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About This Publication

This publication is provided to aid configuration/operation of Universal StationX Release 200
hardware/software.

Use this publication to install, configure, and operate the Universal StationX. If you are unfamiliar
with general LAN (Local Area Network) configuration techniques or details of the specific LAN
configuration to which the station is attached, your Local Area Network Administrator will be
needed to assist in configuration/troubleshooting.
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Section 1 – Universal StationX Release 200  Documentation

1.1 Overview

Available
documentation

The documentation for the Universal StationX Release 200 product is
comprised of manuals published by Honeywell and Hewlett Packard.  All
Hewlett Packard UNIX manuals are at HP-UX Release 9.0 and are
provided via a single compact disc(CD).  The CD can be viewed using a
CD-ROM reader installed in a UXS, another Hewlett Packard workstation,
or a PC with a CD-ROM drive.  A software utility is provided on the
compact discs that is installed and used to read the documentation.  The
documentation can be viewed or printed directly from the CD.  Instructions
for installation are provided with the Hewlett Packard CD.

UNIX manual list by
function

The numerous UNIX manuals can be grouped into functional categories to
guide readers.  Your manual requirement may vary depending on your job
function, current level of UNIX expertise and level of interest.

Publication
Title

System
Administrators

General
Users

A Beginner's Guide to HP-UX √

Administering ARPA Services √

Finding HP-UX Information Series
300/400/700

√

How HP-UX Works: Concepts for
System Administrators

√

HP-UX Reference (3 vols) √

HP-UX System Admin Tasks S700 √

HP-UX System Security √

Inst/Update HP-UX S700 √

Installing and Administering NFS √

Installing and Administering NS √

Installing Peripherals S700 √

Master Index Series 700 √ √

Motif 1.1 Information Manual √

Networking Overview √ √



2 R200 Universal StationX System Administration 4/96

1.1 Overview,  Continued

UNIX manual list by
function , continued

Publication
Title

System
Administrators

General
Users

Read Me Before Installing or Updating
HP-UX

√

Readme HP-UX 9.03 Series 700 √

Remote Access: User's Guide √

Shells: User's Guide √

Solving HP-UX Problems √

Support Tools Mgr User's Guide √

Terminal Control: User's Guide √

Text Formatting: User's Guide √

The Ultimate Guide to the vi and ex Text
Editors

√ √

Using ARPA Services √

Using HP-UX √ √

Using Network Services √

Using NFS Services √

Using Serial Line IP Protocols √

Using the X Window System √ √
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Section 2 – Universal StationX Concepts

2.1 What is Universal StationX

Long term plan In today’s competitive environment, maintaining control of costs and
quality is paramount. Many process industry companies are formulating
long-range plans to meet these objectives. The broad direction is to achieve
low cost operations through the integration of process control and
information system technologies. Honeywell’s TDC (Total Distributed
Control) system will be the foundation of the future CIM (Computer
Integrated Manufacturing) system. This Honeywell system is called
TotalPlant.

To meet these challenges, it is important to provide an evolutionary path of
products, that preserve customer investments in hardware and training. The
Release 100 Universal StationX platform was the first step in implementing
this long term strategy.

To further this evolution, the Release 200 platform contains upgrades to the
Release 100 platform as well as new features. These improvements were
achieved without altering the basic elements of the Universal StationX

platform. This consistency of design preserves the investment in training,
hardware, and software, proving “Consistent Evolution” to be a vital
element in a cost-effective solution.

Definition of Universal
StationX  Release 200

An embedded open system environment provides support for
display/import of data generated on non-LCN platforms. This
TDC 3000X/X Windows integrated platform enables software connections
between the PIN (Plant Information Network) and the LCN (Local Control
Network). Universal StationX is the linking of open systems, X-Windows,
and Motif to produce a visually integrated display of TotalPlant information.

Universal StationX
Release 200

Release 100 of the Universal StationX product provided visual integration
of plant information. Release 200 enables UXS functions to be
added/altered independent of a major LCN software release.

Universal StationX Release 200 provides the following features/benefits:

Features Benefits

Native LCN Window Addition of a menu bar for zoom and LCN
window behavior options.

Key Repeat Timer The keyboard now has a repeat timer that
can be configured

XSAM Internationalization of text to display in the
local (native) language.

Continued on next page



4 R200 Universal StationX System Administration 4/96

Overview,  Continued

Universal StationX
Release 200,
continued

Features Benefits

Zooming Touch Configuration for zooming touch in the LCN
window has been added.

Operator and parallel operator
keyboard

The X server can be configured to always
send key codes to the native LCN window.

X Server supports X11R5 Display of fonts that can be scaled,
consistent color independent monitor type
and support for internationalizing text to
display in the local (native) language.

X Server extensions Enhancements to X server functionality
without affecting standard client operation.

Touchscreen Drag and Drop. Emulates three button mouse, enabling text
editing by drag and drop method.  Also
simplifies point and click.

Multiple PIN windows Simultaneous access to multiple non-TDC
computer systems

Fail Safe Fall Back Ensures the “view to the valve.”

System Security Limits access to authorized users.

TDC system isolated from open system.

Universal StationX
example

The support for the open system allows connection to a wide variety of
hardware platforms.

TDC System Local Area Network

Process
Data

Lab Analysis
Software

U   S Connected to LCN and LAN

51135

x

Continued on next page
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Overview,  Continued

Universal StationX
example , continued

Currently, information on the LAN (Local Area Network) can be displayed
or updated at the Universal StationX. This allows operators to view lab
analysis data on the same screen as the process data. By integrating this
data, the operator has less distractions and requires less training (only one
computer system). A typical control room operator may have two or three
computers to monitor (each holding some essential element of process
data). When the operator’s attention is diverted from the primary TDC
display the potential for problems increases.
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2.2 Universal StationX Hardware

US - Universal StationX
migration

The Universal StationX Release 200 is available in two basic forms:
upgrade kits (for a Universal Station or R100 Universal StationX in
standard furniture), or as a complete station (in standard or ergonomic
furniture). The upgrade kits are available in several versions to match your
specific hardware configuration.

Components The Universal StationX consists of a tightly integrated TDC 3000X

Universal Station and an open system processor environment in a
coprocessor architecture. The Universal StationX contains the following
components:

• Standard US furniture cabinet

• Standard 5-slot module

• New electronics package

• New high resolution monitor (touchscreen optional)

• Hard drive connected to coprocessor

• DAT (Digital Audio Tape) drive connected to coprocessor (one DAT
required per system).

Continued on next page
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2.2 Universal StationX Hardware,  Continued

Component diagram

50442K2LCN

WSI2

HP743

Bernoulli 
Disk

Laser PrinterDisplay Monitors
Communications Modem 

Keyboard
Pointing
Device

802.3 LAN Interface

DAT Tape Drive

Hard Disk Drive(s)

TDC 3000   Printerx

TDC 3000   LCN Interfacex

Enhanced TPDG CD-ROM Drive

New electronics
package

The R200 electronics package consists of:

• Standard K2LCN-8 board

• Workstation Interface board (WSI board)

• Turbo Peripheral Display Generator (TPDG board)

• I/O boards for each of the boards above

• 8 ampere power supply

New monitor A new monitor is used to provide a higher resolution display.  The
resolution is increased to 1280 x 1024 pixels.

Continued on next page
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2.2 Universal StationX Hardware,  Continued

Coprocessor media A hard drive and a DAT (Digital Audio Tape) drive have been added to
contain these Universal StationX files:
• Open system filesystem

• X Window files

• TPDG download code

• Universal StationX (UNPX) personality download code

This media is connected to the Open system coprocessor and is not
accessible by the LCN filesystem.

Specific details For more specific hardware information, refer to Universal StationX

Service.
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Section 3 – Window Operations

3.1 Window Manager

X window system The X Window system provides standards by which computers of
dissimilar types can exchange window displays. This allows computer
systems to execute an application and send the display of that application to
other computer systems which support the X window graphical standard.
This standard integrated the concept of a window manager. The window
manager allows manipulation of the X window displays.

Consistent look The Universal StationX utilizes Motif Window Manager to provide a
consistent look to all applications displayed on the Universal StationX. This
software provides functions for opening, closing, moving, resizing, and
indicating the active window. If you have used Microsoft Windows you
will immediately recognize the similarities.

The Window Manager attributes are preset, and cannot be altered by the
user. System administrators may provide custom configuration of window
attributes on a “system wide” or “user by user” basis.

Functions provided The Motif Window Manager applies the window interface attributes
independent of the application running within a window. The window
interface affects only the manner in which that window is displayed. It will
provide such elements as: title bars, scroll bars, resizing, control of
overlapping windows, and the ability to iconify a window. These elements
allow manipulation of multiple windows, independent of their application or
the underlying computer platform/operating system executing the
application. This allows one window interface to control the display of all
windows appearing on the Universal StationX screen.
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3.2 Cursor Usage

Cursor types The Window Manager uses various cursor types to depict the type of
operation being performed. The types are:

• pointing   or    or  

• working 

• moving 

• resizing   or    or    or    or    or    or    or  
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3.3 Altering Window Size

Changing window size Where you grab the window’s frame determines how the window will be
resized. The dimensions (width x height) of the window being resized is
displayed in the center of the screen. The measurement is in characters
(across) and lines (down) for terminal windows; other types are measured
in pixels (dots on the screen).

Note: When resizing the LCN Native Window, it is necessary to click
the bottom right corner of the window border to cause the LCN
display to resize. The LCN processing continues without
problem, but the display may be only partially visible.

Use the following to change the window size:

If you want to resize the window . . . Point to, depress, and hold the mouse
button and drag. . .

vertically from the . . .

top top of the frame, above the title bar

bottom bottom of the frame

horizontally from the . . .

right right side of the frame

left left side of the frame

diagonally from the . . .

bottom left corner frame’s lower left corner

top left frame’s upper left corner

top right frame’s upper right corner

bottom right frame’s lower right corner

Zoom enhancements Release 200 provides several enhancements to the Native LCN Window. A
menu bar with “Size” and “Options” menus was added to the Native LCN
Window’s window border.

It is important to remember the LCN generates a constant display size which
is resized to fit the window border by the TPDG board. Resize is not an
LCN function, but performing a resize could (depending on circumstances)
trigger other changes to the Native LCN window appearance.

The “Size” menu is used to select the desired size of the Native LCN
window and has the following choices:

• Small — standard one quarter screen size

• Large — full screen size



12 R200 Universal StationX System Administration 4/96

3.3 Altering Window Size (Continued)

Native LCN window
Option Menu

The “Options” menu controls the behavior of the Native LCN window and
has the following items:

• Allow Partial Window Overlay — configures the ability to partially
obscure the Native LCN window with other windows.

• Allow Total Window Overlay — configures the ability to totally
obscure (overlay) the Native LCN window with other windows.  You
currently must select the window a second time for it to overlay the
Native LCN window.

• Zoom Touch active in Full Screen mode — Enables Zoom Touch
when Native LCN Window is displayed at full screen.

• Automatic Resize — maximizes Native LCN window and sets display
to full screen.
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3.4 Minimizing/Maximizing Windows

Minimize a window To reduce workspace clutter, you may change a window to an icon. An
icon is a graphical representation of the application executing in that
window. This reduction to an icon is called “minimizing” a window.
Applications executing in a minimized window continue to execute until the
task is completed or until they require user input.

There are several methods to minimize a window:

• Use the Minimize button on the windows Title Bar

• Use the Minimize selection from the Window Menu

A window which has been minimized (iconified) may be returned to the
window form using several methods.

• Double-Click (click twice in rapid succession) the icon.

• Use the Maximize selection from the minimized window icon menu.

Telnet

%

Minimize
Button

51002

Telnet
Icon

Maximize a window Clicking on the Maximize button will enlarge the window to cover the entire
monitor. Clicking on the button a second time will return the window size
to the original dimensions.

Note: When resizing the LCN Native Window, it is necessary to click
on the bottom right corner of the window border to cause the LCN
display to resize. The LCN processing continues without
problem, but the display may be only partially visible.

Telnet

%

Maximize
Button

51001
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3.5 Using the Window Menu

Window menu Each window has a window menu containing functions for controlling the
window. To access the window menu, point to the menu target and then
press and hold the select button. The menu is displayed as long as the select
button is held down. To select a menu item, drag the cursor down the list
and release the select button when the appropriate item is highlighted.

Telnet

%

Menu
Button

51004

Restore    Alt + F5

Move       Alt + F7

Size       Alt + F8

Minimize   Alt + F9

Maximize  Alt + F10

Lower      Alt + F3

Close      Alt + F4

Window
Menu

To perform the following, select the appropriate menu item:

To do this . . . Select . . .

Restore a window from an icon or after
maximizing.

Restore

Change the location of a window. Move

Change the size of a window. Size

Shrink the window to its icon
representation.

Minimize

Enlarge the window to cover the entire
root window.

Maximize

Send a window to the back or bottom
of the window stack.

Lower

Immediately close the window and
make it disappear.

Close
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3.6 Repositioning Windows

Moving windows Windows can be positioned anywhere on the screen, with one exception.
The Native LCN window is initially configured (for all users except
engineer group members) to inhibit its ability to be partially obscured or
overlapped by other windows. This attribute can be configured for users of
all access levels and is covered in subsection 6.3, Configure Native
Window Behavior.

To move a window, click and drag on the window’s title bar. While
moving, an outline of the window is shown for positioning purposes. The
window will move to this new location if the select button is released at the
current position.

Telnet

%

Title Bar
51003
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3.7 Workspace Menu Access

Workspace menu To reduce the user interaction with the open system environment, a
workspace menu (sometimes called the root menu) is included. This menu
is accessed by holding down the select button within the workspace
(outside all windows). You can select a menu item by dragging the pointer
down the menu list and releasing the select button when that item is
highlighted.

51146

  Operator Menu

Window Menu      >

X Manager Menu   >

Application Menu >

Engineer Menu

Window Menu      >

X Manager Menu   >

Application Menu >

System Menu      >

Supervisor Menu

Window Menu      >

X Manager Menu   >

Application Menu >

View Only Menu

Window Menu    >

X Manager Menu >

Continued on next page
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3.7 Workspace Menu Access,  Continued

Hierarchical menus The menu uses hierarchical (nested) menu items indicated by an arrow to
the right of the item which has another level of menu. To access these
nested menus, hold the select button and scroll to the appropriate menu; the
nested menu item will appear. Moving the cursor onto this new menu will
allow selections to be made from this newly visible list of items.

51007

Applications

Operator Menu

Window Menu       >

X Manager Menu    >

Application Menu  >

Telnet

DECnet

Calculator

Datebook

Access levels The menu is preconfigured according to the access level, which is assigned
by the system administrator. When a user is added to the coprocessor, their
user-login name is associated to a group of users. This association provides
security restrictions by displaying menus specific to that group’s access
authorization.

The access levels are

• operator

• supervisor

• engineer

• view Only



18 R200 Universal StationX System Administration 4/96

3.8 Operator Workspace Menu

Operator Menu items The Operator Menu contains the following:

• Window Menu - a nested menu

• X Manager Menu - a nested menu

• Application Menu - a nested menu

51136

Operator Menu

Window Menu       >

X Manager Menu    >

Application Menu  >

Window Menu items The operator’s Window Menu contains the following:

• Shuffle - Shuffles the position (Up/Down) of the active window.

• Other Screen - This menu item toggles between dual screens allowing
one pointing device and one set of keyboards to control both screens.

• Keyboard Focus Policy - Configures the X Windows attribute
(Explicit/Pointer) to identify the active window. Either a mouse click
(Explicit) or cursor within the window (Pointer) is required to identify
the active window.

• Window Print - Prints the contents of the selected window.

X Manager items The operator’s X Manager Menu contains the following:

• X Host Authorization - Authorizes remote computing resources to
display X applications on this station. Configured for each individual
user.

• Change User Password - allows the user to change their login
password

• Refresh - Performs a redraw of the X application windows.

• Restart - Restarts the Motif Window Manager; used to force a reset of
Motif Window Manager.

• Logout - Sends a kill message to all X hosts to close open applications,
logs the user out, and idles the coprocessor.

Continued on next page
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3.8 Operator Workspace Menu  Continued

Application Menu The operator’s Application Menu contains the following:

• Telnet - accesses the TELNET TCP/IP protocol

• DECnet - accesses the DECnet protocol

• Calculator - a full function calculator application

• Datebook - a calendar/datebook application
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3.9 Supervisor Workspace Menu

Supervisor Menu items The Supervisor Menu contains the following:

• Window Menu - a nested menu

• X Manager Menu - a nested menu

• Application Menu - a nested menu

51137

 Supervisor Menu

Window Menu      >

X Manager Menu   >

Application Menu >

Window Menu items The supervisor’s Window Menu contains the following:

• Shuffle - Shuffles the position (Up/Down) of the active window.

• Other Screen - This menu item toggles between dual screens allowing
one pointing device and one set of keyboards to control both screens.

• Keyboard Focus Policy - Configures the X Windows attribute
(Explicit/Pointer) to identify the active window. Either a mouse click
(Explicit) or cursor within the window (Pointer) is required to identify
the active window.

• Window Print - Prints the contents of the selected window.

X Manager items The supervisor’s X Manager Menu contains the following:

• X Host Authorization - Authorizes remote computing resources to
display X applications on this station. Configured for each individual
user.

• Change User Password - allows the user to change their login
password

• Refresh - Performs a redraw of the X application windows.

• Restart - Restarts the Motif Window Manager; used to force a reset of
Motif Window Manager.

• Logout - Sends a kill message to all X hosts to close open applications,
logs the user out, and idles the coprocessor.

Continued on next page



4/96 R200 Universal StationX System Administration 21

3.9 Supervisor Workspace Menu,  Continued

Application Menu The supervisor’s Application Menu contains the following:

• Telnet - accesses the TELNET TCP/IP protocol

• DECnet - accesses the DECnet protocol

• Calculator - a full function calculator application

• Datebook - a calendar/datebook application
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3.10 Engineer Workspace Menu

Engineer Menu items The Engineer Menu contains the following:

• Window Menu - a nested menu

• X Menu - a nested menu

• Application - a nested menu

• System Menu - a nested menu

 Engineer Menu

Window Menu      >

X Manager Menu   >

Application Menu >

System Menu      >

51138

Window Menu items The engineer’s Window Menu contains the following:

• Shuffle - Shuffles the position (Up/Down) of the active window.

• Other Screen - This menu item toggles between dual screens allowing
one pointing device and one set of keyboards to control both screens.

• Keyboard Focus Policy - Configures the X Windows attribute
(Explicit/Pointer) to identify the active window. Either a mouse click
(Explicit) or cursor within the window (Pointer) is required to identify
the active window.

• Window Print - Prints the contents of the selected window.

X Manager Menu items The engineer’s X Manager Menu contains the following:

• X Host Authorization - Authorizes remote computing resources to
display X applications on this station. Configured for each individual
user.

• Change User Password - allows the engineer to change a user’s login
password

• Refresh - Performs a redraw of the X application windows.

• Restart - Restarts the Motif Window Manager; used to force a reset of
Motif Window Manager.

• Logout - Sends a kill message to all X hosts to close open applications,
logs the user out, and idles the coprocessor.

Continued on next page



4/96 R200 Universal StationX System Administration 23

3.10 Engineer Workspace Menu,  Continued

Application Menu items The engineer’s Application Menu contains the following:

• Telnet - accesses the TELNET TCP/IP protocol

• DECnet - accesses the DECnet protocol

• Calculator - a full function calculator application

• Datebook - a calendar/datebook application

• UNIX Load - a bar chart display of UNIX processor loading

System Menu items The engineer’s System Commands menu contains the following:

• Configuration - a nested menu of configuration items

• Update Software - used to update coprocessor software

• Add/Remove Users - a coprocessor user registration application

• Backup/Restore - used to backup/restore the coprocessor software

Configuration Menu
items

The engineer’s Configuration menu contains the following:

• IWSM Configuration - Shutdown WSI and Native Mode access

• System Configuration - used to configure the coprocessor LAN
environment

• System Terminal - used to open a terminal session window.

• Set Time/Timezone - sets the coprocessor time, date, and timezone
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3.11 View-Only Workspace Menu

X Menu items The View-Only X Menu contains the following:

• Window Menu - a nested menu

• X Manager Menu - a nested menu

51139

View-Only Menu

Window Menu      >

X Manager Menu   >

Window Menu items The Window Menu contains the following:

• Shuffle - Shuffles the position (Up/Down) of the active window.

• Other Screen - This menu item toggles between dual screens allowing
one pointing device and one set of keyboards to control both screens.

• Keyboard Focus Policy - Configures the X Windows attribute
(Explicit/Pointer) to identify the active window. Either a mouse click
(Explicit) or cursor within the window (Pointer) is required to identify
the active window.

• Window Print - Prints the contents of the selected window.

X Manager Menu items The X Manager Menu contains the following:

• X Host Authorization - Authorizes remote computing resources to
display X applications on this station. Configured for each individual
user.

• Change User Password - Allows the user to change their login
password.

• Refresh - Performs a redraw of the X application windows.

• Restart - Restarts the Motif Window Manager; used to force a reset of
Motif Window Manager.

• Logout - Sends a kill message to all X hosts to close open applications,
logs the user out, and idles the coprocessor.
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3.12 Using the Touchscreen

Display resolution The high resolution display required a change to touchscreen operation.
Software is provided to zoom the screen display at 2 times original size.
This zoom touchscreen aids in the selection of small targets.

Zoom feature availability The zoom feature is only available when a user is logged into the
coprocessor environment. The software action is performed as part of the X
window environment and does not effect operation of the application within
the window.

Zooming touchscreen The touchscreen on the Universal StationX is supplemented by software to
aid in selecting small targets in a high resolution display.

When the screen is touched, a zoom window boundary is created
approximately 3 inches around the initial touch point. A zoomed-in view
(2x zoom) doubles the actual size of the display inside the zoom window
boundary. Moving the finger 2 inches to the right moves the image inside
the zoom window only 1 inch. This provides the necessary resolution for
selecting targets in LCN displays set at 1/4 screen.

51014

Native LCN Window

Native LCN Window

Initial Touch Point

Initial Touch Point
with Zoom View

Continued on next page
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3.12 Using the Touchscreen,  Continued

Zooming touchscreen ,
continued

51015

Native LCN Window

Secondary Movement
with Zoom View

Final Position Shows 
Finger Movement is 
Larger Than
Zoom Movement

The proper method of using the zoom touchscreen is to place your finger on
(or as close to) the desired target as possible. This is to reduce the amount
of finger movement necessary allowing selection of targets close to the
screen border. It is important to watch the zoomed view, as the 2:1 ratio of
finger to image movement is initially confusing.
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3.13 Configuring and Using Dual Screens

Overview The Dual CRT function of the UXS release 200 software allows for two
CRTs to be controlled by one set of UXS electronics.  When the dual
screen feature is selected for the UXS software, it can be configured to be
in an over-under configuration or in a side-by-side configuration.  When in
the over-under configuration, screen 0 is located on the bottom with screen
1 being on top.  When in the side-by-side configuration, screen 0 is located
on the left and screen 1 is located on the right when facing the CRTs.

Input devices When using the Dual CRT function of UXS release 200, a single
mouse/trackball and set of keyboards are used for interaction with the
system on either screen.  A Motif Window Manager (mwm) menu selection
can also be configured to “hop” the cursor between screens.

Touchscreen The Dual CRT function of UXS release 200 allows for a touchscreen to be
connected to screen 0.  There is no hardware or software support to allow
for connection of a touchscreen to screen 1.

Limitations When using the Dual-CRT function of UXS release 200, the native LCN
window can only be displayed on screen 0.  All other applications may be
displayed on either screen 0 or screen 1.

Configuration file setup Three files are included in the /usr/lib/X11 directory for the configuration of
Dual CRT functionality.  They are:

• usxserverrc.OnlyOneScreen  (for single crt stations)

• usxserverrc.OverAndUnder  (for vertically oriented screens)

• usxserverrc.SideBySide  (for horizontally oriented screens)

One of these files must be used and linked to the file name “usxserverrc” as
part of the system startup configuration.

Example:

ln  -s  usxserverrc.OverAndUnder  usxserverrc

Required access level The procedures must be performed while logged in as “engineer.”  The
coprocessor (root) password is required.

WARNING Take care when editing this file.  If you make an error when editing file, it
may stop the X-server from running (when you log out).  In this case, the
login banner will not be displayed.  Without the login banner, you will not
be able to login to the Universal StationX to correct your mistake.  To
correct your mistake, you will have to login from a remote device, or
connect a console terminal to the WSI2 I/O board.

Continued on next page
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3.13 Configuring and Using Dual Screens,  Continued

Link usxserverrc to the
appropriate screen
configuration file

Perform the following steps to configure the system (X server) for the
appropriate screen configuration:

Step Action

1 Select System Menu->Configuration->System Terminal
from the Workspace Menu.

2 Enter the coprocessor (root) password and press <RETURN>.

Note:  Only <RETURN> is necessary on a new station.

3 From the shell prompt, enter cd /usr/lib/X11 and press
<RETURN>.

4 Unlink usxserverrc from the file to which it is currently linked by
entering unlink usxserverrc and pressing <RETURN>.

5 From the shell prompt, use the link command to link usxserverrc to
the appropriate screen configuration file.  Use one of the three
commands that follow:

ln -s usxserverrc.OnlyOneScreen usxserverrc

ln -s usxserverrc.OverAndUnder usxserverrc

ln -s usxserverrc.SideBySide usxserverrc

Setup Motif for multiple
screens

Perform the following steps to configure the Motif window manager for
multiple screens.

Step Action

1 Edit /usr/lib/X11/system.Xdefaults to change (if necessary)
the following resource to be setup as true:

Mwm*multiScreen: true

The following commands can be used to edit the file:

Note:  Unless specified, do NOT press <RETURN>.

a. vi system.Xdefaults and press <RETURN>.
b. /multi and press <RETURN>.
c. W
d. cw
e. true
f. <ESC>
g. :wq! and press <RETURN>.

Note: You must logout and login to make your screen configuration
effective.

2 Enter exit and press <RETURN>.

Continued on next page



4/96 R200 Universal StationX System Administration 29

3.13 Configuring and Using Dual Screens,  Continued

Command line use To display a window on the second screen you must use the ”-display”
option when invoking the application.  For example:

xclock -display unix:0.1 <RETURN>

This will start the application “xclock” on the second screen (screen 1).  If
you use “-display unix:0.0”, the application will be displayed on the first
screen (screen 0).

Refer the Hewlett-Packard manual “Using the X Window System” for more
detailed information on X Window usage.

.mwmrc file use You can add “-display unix:0.1” to the f.exec definition for the Motif menu
items.

Default as screen 0:

"Calculator"f.exec "xcalc -geom 220x280-160+4 -fn
9x15 &"

With -display added to go to screen 1:

"Calculator"f.exec "xcalc -display unix:0.1 -geom
220x280-160+4 -fn 9x15 &"

Note If an application is started from a Motif menu and there is no definition for
the display to use, the application will start up on the screen from which it
was invoked.
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Section 4 – Universal StationX Operations

4.1 Power-On (Procedure)

Apply power Apply power using the following steps:

Step Action

1 Place the station circuit breaker in the ON position.

2 Open the rear access door to gain access to the 5-slot module.

3 Apply power to the station using the power switch on the 5-slot
module faceplate.

4 Observe the K2LCN board LEDs during the power on self-test. If no
errors are detected, the appropriate LCN node address is displayed.

5 If the appropriate LCN node address is displayed
Proceed with Step 6.

If another number is displayed
Record the error number for maintenance personnel to assist in
correcting the fault.

If the banner does appear within 5 minutes
Proceed with Step 8 to shut down the coprocessor.

If the Login banner has not appeared
Proceed with Step 11.

6 The Login banner should appear within 5 minutes.

7 If the Login banner does appear
Proceed to subsection 4.2, Accessing Coprocessor Functions.

If the Login banner has not appeared
Proceed with Step 11.

8 Position the cursor in the Login box and type
username <RETURN>

Note:  The user must be authorized to shut down the WSI.

9 Position the cursor in the Password box and type
password <RETURN>

Note:  Replace password with your password.
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4.2 Accessing Universal StationX Coprocessor Functions
(Procedure)

Coprocessor access
banner

After power ON (3 to 5 minutes) the Universal StationX will display a
banner on the lower portion of the screen.

This banner allows access to:

• X windows environment

• Shutdown of the coprocessor

• Universal StationX Native Mode operation.

These items are user and password restricted to maintain security and
restrict access to the coprocessor or LAN environment.

Using the access
banner

Using the touchscreen:

Step Action

1 Touch the Login field.

2 Type your username <RETURN>.

3 Type your password.

4 To Login:
Press <RETURN>

To Shutdown the Coprocessor
Touch the Shutdown WSI target and select it with the space bar.

To revert to Standard Universal Station Operation
Touch the Native Mode target and select it with the space bar.

Using the mouse or trackball:

Step Action

1 Select the Login field by placing the cursor over the field.

2 Type your username <RETURN>.

3 Type your password.

4 To Login
Press <RETURN>

To Shutdown the Coprocessor
Select the Shutdown WSI target.

To revert to Standard Universal Station Operation
Select the Native Mode target.
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4.3 Loading a Personality to the LCN Processor

Capabilities The Universal Personality has been encapsulated in a “Windows
environment” to form the UNPX Personality stored on the coprocessor
hard drive. This integration enables the Universal StationX to function as
either a Universal StationX or a standard TDC 3000X Universal Station.

The X window capabilities are available only when functioning as a
Universal StationX. As a Universal StationX, the presentation of all displays
will be controlled by the X windows/Motif Window Manager to provide the
addition of such items as title bar, zoom box, and scroll bars.

Hardware tests A fully operational Universal StationX system can use the UNPX
personality. When power is applied, the system performs a series of
internal self-tests. These tests check the presence and condition of both the
TDC and coprocessor hardware. The results determine the loading action
available when <Load> is pressed.

If test result is ... then loading action available is ...

TDC and coprocessor hardware OK UNPX personality from hard drive or
UNP, ENG, or OPR from History
Module

TDC hardware OK/coprocessor test
failure

UNP, ENG, or OPR from History
Module or Removable Media

TDC and coprocessor hardware failure No loading performed

Loading the personality The Universal StationX may be loaded from several sources:

• History Module
• Removable Media (cartridge or floppy)
• Internal coprocessor hard drive

The Universal StationX can be loaded from other stations (Universal
StationX or US) on the LCN.  However, when loaded locally, the hardware
tests will control the appropriate prompt. For example, failure of the
coprocessor will inhibit the load prompt from displaying the appropriate
choice (W).

There are four personalities available to be loaded into the Universal
StationX.  They are: OPR, ENG, UNP, UNPX.  The first three are
available from the History Module or removable media, the last (UNPX)
can be loaded only from the coprocessor.  To get full Universal StationX

functionality, the LCN processor must be loaded with the UNPX
personality.  This allows data (point.parameter) to be transferred from the
“LCN side” to the “UNIX side”.  Logging into a windowing environment
is available regardless of what LCN personality is loaded.

Continued on next page
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4.3 Loading a Personality to the LCN Processor,  Continued

ATTENTION Touch screen functionality is not available during the load of the LCN
processor.

ATTENTION If you are upgrading from a K2LCN to a K4LCN, you need to perform the
following commands in order for the loading of the personality from “W” to
complete successfully.  These commands should be done prior to shutting
down the system for the K2LCN to K4LCN board swap, or if this has
already been down, prior to pressing the LOAD key.  These commands can
only be executed by “root”.

Step Action

1 Make sure you are in the appropriate directory.

cd /etc/opt/TDC_Open/common

2 Remove the old personality file.

rm personality.config

3 Establish a symbolic link from the new personality
file(personality.config.usxk) to the active personality
file(personality.config). The format for the command is:

ln  -s  filename  linkname

Example:

ln -s /opt/TDC_Open/common/newconfig/personality.config.usxk
personality.config

Load the LCN
processor

Use the following procedure to load the LCN processor.  The touch screen
is not active during this process and should not be used.

Step Action

1 If the access banner is on the screen
Press <Load> on the operator keyboard.

If you are already logged in
Select the Native LCN Window, press <Load> on the operator keyboard.

2 At the prompt W, N, 1, 2, 3, 4, X type W,Press <Enter>

3 The load modules will be displayed as the LCN processor is loaded.

4 At the prompt NCF? N,1,2,3,4,X? type N, Press <Enter>

5 The station will complete the load process in 1 to 2 minutes.



4/96 R200 Universal StationX System Administration 35

4.4 Printing from the Universal StationX

Two printers The Universal StationX has two printer connections.

The standard LCN printer connection provided to print LCN displays and
reports is configured as a standard Universal Station printer. This printer is
functional whenever the station is in operation. The LCN printer can be
connected directly to a Universal StationX or assigned from another station
in the console (US or Universal StationX). Standard Universal
StationX operating procedures apply to the printing of reports, alarm
summaries, configuration data, print displays, etc.

The coprocessor has a printer connection provided to print window dumps
of X Window applications. This printer is available only when the user is
logged into the coprocessor; however, printing will still continue after
logging out. This printer will not print the various Universal Station Printer
functions of alarm summaries, reports, etc. The coprocessor printer can be
directly attached to this Universal StationX or shared across the LAN from
another Universal StationX.

Printing the LCN
window

The LCN processor must be active to print. The user can be logged into the
coprocessor, but it is not required to print LCN data.

To print the LCN window on the LCN printer, use the following:

Step Action

1 If logged into the coprocessor
Select the LCN window.

2 Press the Print Display key.

Printing X Windows When the user is logged into the coprocessor, the coprocessor printer can
be used to print any window contents. To print to a shared printer, the
coprocessor of the Universal StationX sharing the printer must be active
(login banner displayed or a user logged in).

To print any X Window on the coprocessor printer, use the following:

Step Action

1 Select Window Print from the workspace menu.

Note:  The cursor will change to a cross-hair pointer.

2 Position the cursor in the appropriate window to print.

3 Click the select button.
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4.5 Failsafe Operation

Failsafe fall back The Universal StationX is designed to be failsafe. Should an error occur in
the coprocessor, the Universal StationX reverts to a standard TDC
Universal StationX hardware/software configuration. If this should occur,
the LCN display will revert to full screen and the message  Coprocessor
has failed to start, Call maintenance  will be displayed in place
of the Login banner.

When functioning as a standard Universal Station, you will be unable to
access LAN (Local Area Network) resident applications.

Native mode The Universal StationX can be configured as a standard Universal Station
by selecting Native Mode from the Login banner. To enter Native Mode,
the user must be authorized using the procedures covered in IWSM
Configuration, Universal StationX System Administration Manual.

Manual shutdown The coprocessor can be shut down after power-on using the Shutdown WSI
target located on the login prompt. This action can also be performed by
logging out of the open system session and waiting for the login prompt to
appear.

To invoke the failsafe condition:

• At the login prompt, enter your login name/password and select the
Shutdown WSI target.

Shutdown restriction To shutdown the WSI, the user must be authorized using the procedures
covered in “IWSM Configuration,” Universal StationX System
Administration Manual.

Restarting after
shutdown

After the coprocessor has been shutdown, a status message will appear in
the Login banner area. The message is:
The coprocessor is idle, select the box to reset.

There is a red box to the right of the status message. Using the mouse, click
on the box to reset the coprocessor.
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4.6 Universal StationX Display Changes

TDC display changes Several changes are apparent when operating from the Universal StationX.
Some changes are due to TDC software Release 430, and are not Universal
StationX inherent.

• Console and Node Status Displays
A field for the personality type has been added. The node status is not
overwritten by personality type when status is OK.

• Console Status Display
Ability to choose the personality which is loaded to a Universal
StationX has been added. The autoload_net target determines the
default personality to load by testing the hardware.

• Real Time Journal Changes
The System Maintenance Journal is updated with additional messages
to support the new TPDG hardware. The System Status Change
Journal will be updated with a new message—State Change
Notification (SCN) to establish the personality subtype in a node.
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4.7 X Window Operation

Background The Universal StationX is configured to launch the X window environment
upon login. Once the system has initialized, the primary LCN display
window appears. At this time you can start an X window session with LAN
resident computing resources.

Prerequisites The LAN computing resources must be configured to allow access from the
Universal StationX. In general terms, the following information is required
by the LAN hardware and/or application software:

• Universal StationX internet address

• System name

• User name/password for its login

Choosing emulators
and protocols

To access LAN-resident applications you will use a communication protocol
(either TCP/IP or DECnet), and a terminal emulator (either xterm or vt340).
The DECnet protocol and the vt340 terminal emulator are optional packages
on the Universal StationX.

Terminal Emulator Protocol Menu Selection Command(s)

vt102 (xterm) Telnet TCP/IP Telnet open hostname

vt102 (xterm) DECnet Telnet !
sethost hostname

vt340 Telnet TCP/IP DECnet telnet hostname

vt340 DECnet DECnet sethost hostname

Procedure LAN resident applications may not be Honeywell supplied; therefore, these
access procedures are general in nature.

Step Action

1 Login to the Universal StationX.

2 Determine the appropriate terminal emulator and protocol.

3 Make the appropriate menu selection (to select the desired terminal
emulator).

4 Enter the appropriate command(s) (to initiate a login sequence to the
remote LAN device using the desired protocol).

5 Log in to the remote LAN device.

6 Enter the appropriate command(s) to launch the application in the
remote LAN device.
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4.8 System Security

TDC isolated The TDC operating system is isolated and inaccessible to the coprocessor.
This eliminates the possibility of misuse/tampering with the process control
system by unauthorized personnel who may gain access to the Local Area
Network.

The full implementation of HP-UX version 9.0 security features are
provided. System security is controlled through the configuration and login
utilities.

Configuration Configuration parameters ensure only designated computer systems will be
able to login to the Universal StationX. This allows multiple computer
systems to exchange data transparently while ensuring data integrity
through limited authorized access.

The coprocessor password should be changed and recorded during initial
configuration. This password is the highest level of system access and
system security must be enforced by good password discipline.

Login A password controlled login utility protects against unauthorized Universal
StationX coprocessor usage. This utility configures access dependent on the
user-login identification. The system customizes the workspace menu as
appropriate to the access level of the user. Access to additional items can be
provided to individual users by modifying the .mwmrc file in the users home
directory.

Access keylock versus
coprocessor login

This login utility performs a function similar to the Access Level Keylock
on the standard Universal Station; however, the coprocessor login is
entirely independent from the keylock mechanism. System security may be
compromised if the user leaves the immediate area without logging out of
the coprocessor environment.

It is suggested to remove the access level key and logout of the coprocessor
environment to ensure against unauthorized access to the LCN system.

Emphasize security Users should be reminded of the potential security risks. A periodic review
of the system security, security procedures, and system users will help to
raise awareness. Remind users that the password is their computer
signature. Emphasize the importance of periodically changing this
password.

Continued on next page
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4.8 System Security,  Continued

Coprocessor access by
group

The restrictions placed upon access levels are:

• Operator—able to configure their own environment, use telnet, and the
optional VT340 DECnet communications

• Supervisor—able to configure their own environment, use telnet, and the
optional VT340 DECnet communications

• Engineer—able to configure their own environment, use telnet, the
optional VT340 S/W, coprocessor configuration (requires coprocessor
password), and perform periodic backups of the coprocessor file system

• View Only—able to configure their own environment.

Note: User-configurable items are: X Hosts, allowPartiallyObscured Native
Window, and Keyboard Focus Policy.

Remote user
configuration

To configure the remote user coprocessor security features, review the
procedures, gather the required information, and perform all tasks in
Section 5, “Configure Security for Remote Users”.
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4.9 Shut Down the Universal StationX

Background To prevent damage to the UNIX filesystem, the station must be shut down
using a special sequence. The shutdown procedure must be followed before
power is removed from the station. Only those users configured in IWSM
configuration are allowed to shutdown the coprocessor.

Failure to perform the proper shutdown procedure could result in damage to
the coprocessor filesystem. The next time the station is powered up, it may
take up to 5 minutes to perform automatic repairs of the coprocessor
filesystem. Use caution in cycling power on and off. If this is done while a
repair is being made, the filesystem may be left in an unrepairable state.
This would require reloading the filesystem backup from tape and possibly
require reformatting or replacement of the hard drive.

Procedure If you are currently logged into the Universal StationX, use the following
procedure:

Step Action

1 Select Logout from the root menu.

2 At the prompt Quit Mwm?, select the OK target.

3 When login menu appears, enter your username and password.

Note:  Do not press <RETURN> after entering your password.

4 Select SHUTDOWN WSI target.

5 Press the CONSOLE STATUS key.

6 Select the node number of the appropriate Universal StationX.

7 Select the SHUTDOWN target.

8 Press ENTER to confirm the shutdown request.

If no user is logged into the Universal StationX, use the following
procedure:

Step Action

1 When login menu appears, enter your username and password.

Note:  Do not press <RETURN> after entering your password.

2 Select the SHUTDOWN WSI target from the login menu.

3 Press the CONSOLE STATUS key.

4 Select the node number of the appropriate Universal StationX.

5 Select the SHUTDOWN target.

6 Press ENTER to confirm the shutdown request.
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4.10 Universal StationX Restrictions

Shutdown procedure Because the coprocessor operating system is incorporated into the Universal
StationX, the station must be turned off using a special sequence. The
shutdown procedure must be followed any time power is to be removed
from the station.

Failure to perform the proper shutdown procedure could result in damage to
the coprocessor filesystem. The next time the station is powered up it may
take 5 minutes to perform automatic repairs to the coprocessor filesystem.
Use caution in cycling power on and off. If this is done while a repair is
being made, the filesystem may be left in a unrepairable state. This would
require reloading the filesystem backup from tape, and possibly require
reformatting or replacement of the hard drive.

Coprocessor red box
target

Under most circumstances the coprocessor “red box” target should not be
selected as the system is in the process of a self reset and the red box will
go away on its own.  Selecting the red box prematurely can cause UNIX
related file problems.  If you feel the red box target has been displayed for
an unusually long time, wait a minimum of 10 total minutes before selecting
it for a system reset.
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4.11 Technical Assistance

If you need assistance If you need technical assistance, contact your local Honeywell Service
Organization, as explained in the following paragraphs.

International customers Outside of the United States, contact your local Honeywell Service
Organization. If you are not sure of the location or telephone number, call
your Honeywell representative for information.

Customers inside the
United States

Within the United States, call the Technical Assistance Center (TAC) at the
toll free number 1-800-822-7673.

Arizona customers Within Arizona, the local number for TAC is 602-863-5558.

Services provided Calls to TAC are answered by a dispatcher from 7:00 A.M. to 5:00 P.M.,
Mountain Standard Time (6:00 A.M. to 4:00 P.M. when daylight saving
time is in effect). Outside of these hours, emergency calls are those which
affect your ability to control or view a process will be received by an
answering service, and returned within one hour. TAC maintains its own
TDC 3000X system, and frequently can duplicate problems on this
equipment.

Time saving tip It is a good idea to make specific notes about the problem before making the
call. This will help to reduce delays and expedite answers.
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Section 5 – Coprocessor Configuration Tasks

5.1 Configuration Overview

LCN requirements The Universal StationX requires TDC 3000X software Release 430. The
Universal StationX does not place any new requirements on LCN software
or hardware. Approach the Universal StationX planning and implementation
tasks as a standard Universal Station. All the LCN conventions for
Universal Station implementation apply to the Universal StationX such as:
node addressing, HM volume allotments, and NCF changes.

The Universal StationX uses all LCN schematics/overlays without any data
conversion. The Universal Station and Universal StationX are equivalents
as TDC 3000X Process Control Computers. The Universal StationX can
load the standard personalities (UNP, ENG, and OPR) from the History
Module or Removable Media, and also can load the UNPX personality
from the coprocessor hard drive.

When loading the UNPX from the coprocessor hard drive, the button
overlays, abstracts, schematics, and NCF are all read from the HM. The
coprocessor hard drive stores only the QLTs and UNPX files for the
K2LCN processor. The additional files cannot be stored on the coprocessor
hard drive and must be loaded from the HM or Removable Media.

Currently, the UNPX personality is the functional equivalent of the UNP
stored on the History Module; however, pending UNPX enhancements, it
may provide functionality to the Universal StationX that would not be
available at the US.

NCF changes Several fields were added to the NCF (Network Configuration File) to
support Release 430. The NCF must be modified to reflect the Universal
StationX installation. This is done by following the standard NCF
modification instructions available in the R430 Release Guide.

The NCF must reflect that a Universal StationX is present at the LCN node
address pinned on your Universal StationX.  LCN node configuration, and
console assignment must be completed prior to applying power to the
station.

The NCF has the following changes: new personality type—Universal
StationX, new board type—TPDG, new board type—WSI2.

The SMCC (System Maintenance Control Center) has the following change:
new board type—TPDG.

Continued on next page
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5.1 Configuration Overview,  Continued

Coprocessor
configuration

The major difference when compared to a Universal Station is the Universal
StationX's ability to display non-TDC 3000X applications, generated by
LAN (Local Area Network - Ethernet) computing resources. The TPDG
board works in tandem with the coprocessor, providing the TDC display as
an X client, which then is displayed through the X window/Motif
environment.

There are several attributes new to the TDC display, which are necessitated
by viewing in the X window environment.

Installation complete? This procedure assumes the Universal StationX equipment to be properly
installed and ready to apply power.

The following items must be completed, prior to the initial power on/login:

• Uncrating/positioning of the Universal StationX equipment.

• Ground connections (power, cabinet, and Master Reference Ground)

• LCN node address pinning

• LCN cable connections

• LAN interface cable and transceiver attached to the Ethernet network

• Universal StationX keyboard connection

• Universal StationX mouse/trackball connection

• LCN printer connection (optional equipment)

• Laser printer connection (optional equipment)

• Visual inspection of all boards/cables to ensure proper seating

• Power Connection

Continued on next page
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5.1 Configuration Overview,  Continued

Make a copy You will find it convenient to make a copy of the following lists for
reference when performing the configuration procedures.

Required information The information required to complete this process is listed below.

Desired hostname for the Universal StationX                                            
Desired IP address                                            
Time/Date/Timezone                                            
Multiple network routers (Yes/No)
(Single router only) IP address of router                                            

Remote computer system information can be input in one of two ways:
1) Hostname and IP address for each when entered manually.

  hostname                            ###.###.###.###             
                                                                                      
                                                                                      
                                                                                      
                                                                                      
                                                                                      
                                                                                      
                                                                                      
                                                                                      
                                                                                      
                                                                                      
                                                                                        

2) Source of existing /etc/hosts file when using ftp.
IP address of source                                            
Login account at source                                            
Password for account                                            

Coprocessor laser printer? (Local/Remote/Unused)
If Remote - Network information needed

Hostname of print server                                            
IP address of print server                                            
Printer name                                            

Continued on next page
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5.1 Configuration Overview,  Continued

Required information,
continued

Coprocessor user information
Username/Access Group   johndoe/Engineer                   

                                                 
                                                 
                                                 
                                                 
                                                 
                                                 
                                                 
                                                 
                                                 
                                                 
                                                 

Shutdown WSI access   username                                
                                                 
                                                 
                                                 
                                                 
                                                 
                                                 
                                                 
                                                 
                                                 
                                                 
                                                 

Native mode access   username                                
                                                 
                                                 
                                                 
                                                 
                                                 
                                                 
                                                 
                                                 
                                                 
                                                 
                                                 

X hosts to be accessed   hostnames                              
                                                 
                                                 
                                                 

Continued on next page
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5.1 Configuration Overview,  Continued

Required information,
continued

Desired coprocessor password                                                  

Note: This password is extremely important. It is the key to your
coprocessor security. Secure this document and control its access
after completing the initial configuration.

Configuration checklist Use this checklist to plan and record the various configuration tasks.

Step Initials Step performed Subsection Approx. time

1 Ensure installation complete?

              Uncrating/positioning of the
Universal StationX
equipment.

              Ground connections
(power, cabinet, and Master
Reference Ground)

              LCN node address pinning

              LCN cable connections

              LAN interface cable and
transceiver attached to the
Ethernet network

              Universal StationX keyboard
connection

              Universal StationX
mouse/trackball connection

              LCN printer connection
(optional equipment)

              Laser printer connection
(optional equipment)

              Visual inspection of all
boards/cables to ensure
proper seating

              Power connection

              Information prepared

N/A 1 hour

2 Initial power on completed? 5.2 3-5 minutes

3 Initial login completed? 5.3 1 minute

4 Coprocessor password configured? 5.4 5 minutes

5 Time/date/timezone entered? 5.5 2 minutes

Continued on next page
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5.1 Configuration Overview,  Continued

Configuration checklist,
continued

Step Initials Step performed Subsection Approx. time

6 Station coprocessor hostname and
Internet Protocol address entered?

5.6 5 minutes

7 Remote hostnames and addresses
entered?

5.7 4-10 minutes

8 Network routing configured? 5.8 4-10 minutes

9 Coprocessor printers configured? 5.10 15-20
minutes

10 Shutdown WSI access configured? 5.11 2-30 minutes

11 Native mode access configured? 5.11 2-30 minutes
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5.2 Initial Power-On

Apply power Apply power using the following steps:

Step Action

1 Open front access door to gain access to the circuit breaker.

2 Place the circuit breaker in the ON position.

3 Open the rear access door to gain access to the 5-slot module.

4 Apply power to the station, using the power switch on the 5-slot
module face plate.

5 Observe the K2LCN board LEDs during the power on self-test. If no
errors are detected, the appropriate LCN node address is displayed.

6 If the appropriate LCN node address is displayed
Proceed with Step 7.

If another number is displayed
Record the error number and contact maintenance personnel to
correct the fault. Proceed with Step 9.

7 Wait 5 minutes for the Login banner to appear.

8 If the Login banner does appear
Proceed with subsection 5.3, Initial Login.

If the Login banner has not appeared
Proceed with Step 9.

9 Using the power switch located on the 5-slot module faceplate,
remove power from the 5-slot module.

10 Set the station circuit breaker to the OFF position. Contact
maintenance to correct the fault.
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5.3 Initial Login

Preconfigured users The Universal StationX coprocessor environment is preconfigured with one
user in each of the four groups. The initial login passwords of the
preconfigured users should be changed to ensure security.

The steps for changing the preconfigured user passwords are presented
following the initial configuration procedures covered in this section.

Coprocessor (root)
password

The coprocessor itself must be password protected; however, to ease
installation it is shipped without a password. During initial installation
procedures, the coprocessor has no password. When asked to type the
password, press <RETURN>.

Only users with Engineer Access rights have configuration access to the
coprocessor environment. Prior to obtaining access, however, the user
must provide the coprocessor (root) password.

The steps for changing the coprocessor (root) password is presented
following the initial configuration procedures.

Initial login passwords The preconfigured user names and passwords are as shown:

User Name Password Coprocessor Access

engineer engineer Engineer Access

operator operator Operator Access

supervisor supervisor Supervisor Access

viewOnly viewOnly View-Only Access

Login Login as the user “engineer,” using the steps below:

Step Action

1 Position the cursor in the Login box and type engineer <RETURN>

Note: The password box will be selected. Do not move the
mouse/trackball. If the cursor is moved, it will be necessary to
reposition the cursor over the password box.

2 Type the password engineer <RETURN>.
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5.4 Change Coprocessor (root) Password

Required access level The procedures must be performed while logged in as “engineer.”  The
coprocessor (root) password is required.

Menu appearance

51143

Engineer Menu

Window Menu      >

X Manager Menu   >

Application Menu >

System Menu      >

Configuration

IWSM Configuration ...

System Configuration ...

System Terminal ...

Set Time/Timezone ...

System Commands

Configuration    >

Update Software  >

Add/Remove Users ...

Backup/Restore ...

Change the
coprocessor (root)
password

Changing the coprocessor (root) password to ensure security.

Step Action

1 Select System Configuration from the workspace menu.

2 Type the coprocessor (root) password and <RETURN> at the prompt.

Note:  Only <RETURN> is necessary on a new station.

3 Using the arrow keys and <RETURN> to make selections,

Select Users and Groups<RETURN>.

4 Select Users<RETURN>.

5 Select the line of the display containing the login name of “root” with
the left mouse button.

6 Select Actions at the top of the window.

7 Select Modify.

Note:  You will be prompted to confirm this action.  Select Yes.

8 Select the Change Password target located in the lower left corner
of the window.

9 Enter the new password<RETURN>.

10 Re-enter the new password<RETURN>.

11 Select Ok.

Continued on next page
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5.4 Change Coprocessor (root) Password,  Continued

Change the
coprocessor (root)
password, continued

12 Select Ok.

13 Select File from the top of the Users and Groups window.

14 Select Exit.

15 Select Exit Sam target.
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5.5 Configure Coprocessor Time and Timezone

Required access level The procedures must be performed while logged in as “engineer.”  The
coprocessor (root) password is required.

Menu appearance

51141

Engineer Menu

Window Menu      >

X Manager Menu   >

Application Menu >

System Menu      >

Configuration

IWSM Configuration ...

System Configuration ...

System Terminal ...

Set Time/Timezone ...

System Commands

Configuration    >

Update Software  >

Add/Remove Users ...

Backup/Restore ...

Set time/timezone Set the time, date, and timezone using the following procedure.

Step Action

1 Select  Set Time/Timezone from the System Configuration
menu.

2 Type the coprocessor (root) password and <RETURN> at the prompt.

3 Respond to the prompts using the appropriate  keyboard entry and
<RETURN> to enter values.

4 It is a good idea to reboot the system after entering date and time.
This will ensure that the system uses the correct time and date for
time dependent functions such as cron, and file time stamps.

Note:  If you are setting the time as part of an initial coprocessor
setup, you can defer the reboot process until after the coprocessor
node name and IP address procedure.
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5.6 Configure Coprocessor Node Name and IP Address

Required access level The procedures must be performed while logged in as “engineer.”  The
coprocessor (root) password is required.

Menu appearance

51140

Engineer Menu

Window Menu      >

X Manager Menu   >

Application Menu >

System Menu      >

Configuration

IWSM Configuration ...

System Configuration ...

System Terminal ...

Set Time/Timezone ...

System Commands

Configuration    >

Update Software  >

Add/Remove Users ...

Backup/Restore ...

Procedure Overview A special utility called “set_parms” is used on a UXS station to set up the
coprocessor host name and the internet protocol (IP) address.  Be prepared
to supply these two entries.  The coprocessor must be rebooted to enable
the change.

Procedure instructions

Step Action

1 Select System Menu->Configuration->System Terminal
from the Workspace Menu.

2 Enter the coprocessor (root) password <RETURN>.

Note:  Only <RETURN> is necessary on a new station.

3 At the prompt enter /etc/set_parms hostname<RETURN>.

Note:  Enter the characters h o s t n a m e.  Do not enter the hostname
of your station here.  The set_parms program will prompt you to enter
the hostname of your station.

4 Respond to the prompts using appropriate keyboard entries for your
configuration.  Use <RETURN> to enter values.

Note:  When asked if you want to reboot now, enter n  and press
<RETURN>.  You will reboot the station later in this procedure.

5 After returning the the system terminal window prompt, you must now
configure the station coprocessor hostname for DAT tape backups.

Enter  cd /usr/lib/X11<RETURN>.

Continued on next page
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5.6 Configure Coprocessor Node Name and IP Address,
Continued

Procedure instructions,
continued

Step Action

6 Edit the system.Xdefaults file.

Enter  vi system.Xdefaults<RETURN>.

7 Search the file for the first instance of <host.

Enter  /<host <RETURN>.

8 Change <host name> to the actual hostname of your station.

Enter  :s/<host name>/{coprocessor name}<RETURN>.

Note:  Substitute {coprocessor name} with the actual name of
your station as entered earlier in this procedure.  Do not include the
curly brackets in your command.

Example:  :s/<host name>/trn2 <RETURN>.

9 Un-comment this line.

Position the cursor on the ! at the beginning of the line.  Type x to
remove it.

10 Save the file and quit the editor.

Enter  :wq!<RETURN>.

11 Enter reboot -q<RETURN>

Note:  This will cause the coprocessor to reboot .  This enables the
new hostname and IP address.  Do not touch the red target that
appears during reboot.
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5.7 Configure Coprocessor LAN Information

Required access level The procedures must be performed while logged in as “engineer.”  The
coprocessor (root) password is required.

Menu appearance

51143

Engineer Menu

Window Menu      >

X Manager Menu   >

Application Menu >

System Menu      >

Configuration

IWSM Configuration ...

System Configuration ...

System Terminal ...

Set Time/Timezone ...

System Commands

Configuration    >

Update Software  >

Add/Remove Users ...

Backup/Restore ...

Enter LAN information Setup remote hostnames, and their TCP/IP addresses using the following
procedure.

Step Action

1 Select System Configuration from the workspace menu.

2 Type the coprocessor (root) password and <RETURN> at the prompt.

Note:  Only <RETURN> is necessary on a new station.

3 Select Networking/Communications <RETURN>.

4 Use the arrow keys and <RETURN> to make selections.

Select System to System Connectivity <RETURN>.

5 Select Internet Connectivity <RETURN>.

6 Using the mouse pointer select Actions from the top of the
window.

7 Select Add.

8 Enter the IP address of the remote system and press <RETURN>.

9 Enter the remote system name<RETURN>.

Note:  Hostnames can consist of a maximum of 64 alphanumeric,
underscore, and period characters.

10 Select Ok.

11 Repeat steps 7-10 as necessary.

Continued on next page
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5.7 Configure Coprocessor LAN Information,  Continued

Enter LAN information,
continued

Step Action

12 Select File from the top of the window.

13 Select Exit.

14 Select Exit SAM.
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5.8 Configure LAN Routing Information

Routing choices The Universal StationX coprocessor may be configured for either static or
dynamic routing of LAN information.  The Universal StationX is
configured by default for static routing. Typically the routing configuration
will be supplied by a network support individual responsible for the
Management of the LAN.

If the LAN has no routers or only one router, the gated daemon should not
be used and the hostname and TCP/IP address for the default gateway
should be configured.

If the LAN uses multiple routers and hosts which are configured with
subnet masks, it will be necessary to configure and use the gated daemon.
The coprocessor will interrogate the routers and use the routers dynamic
routing table information.  Configuring the gated daemon process is
covered in the Hewlett Packard document  “Installing and Administering
ARPA Services.”

Required access level The procedures must be performed while logged in as “engineer.”  The
coprocessor (root) password is required.

Menu appearance

51143

Engineer Menu

Window Menu      >

X Manager Menu   >

Application Menu >

System Menu      >

Configuration

IWSM Configuration ...

System Configuration ...

System Terminal ...

Set Time/Timezone ...

System Commands

Configuration    >

Update Software  >

Add/Remove Users ...

Backup/Restore ...

Continued on next page
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5.8 Configure LAN Routing Information,  Continued

Setup of static LAN
routing

The default gateway can be set using the following procedure:

Note: You must complete the “Configure Coprocessor Node Name and IP
Address” procedure before you perform this procedure.

Step Action

1 Select System Menu->Configuration->System
Configuration from the workspace menu.

2 Enter the coprocessor (root) password and press <RETURN>.

Note:  Only <RETURN> is necessary on a new station.

3 Note:  Use the mouse/trackball (double click) or the arrow keys and
<RETURN> to make selections.

Select Networking/Communications.

4 Select System to System Connectivity.

5 Select Internet Connectivity.

6 Using the mouse/trackball pointer select Actions->Add from the
top of the window.

7 Enter the IP address of the default gateway node.

8 Enter the hostname of the default gateway node.

9 Select the Ok target.

10 Using the mouse/trackball pointer select Actions->Specify
Default Gateway from the top of the window.

11 Enter the default gateway internet address.

12 Select the Ok target.

13 Using the mouse/trackball pointer select File->Exit from the top of
the window.

14 Select the  Exit SAM target.
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5.9 Configure Security for Remote Users

Overview The default configuration of your Release 200 system does not allow any
remote users to connect to the station.  The file inetd.sec, which is located
in the /usr/adm directory, is used for this purpose.  Refer the Hewlett-
Packard manual titled “Using ARPA Services” for a detailed discussion of
this file.

WARNING The inetd.sec file may be overwritten during a coprocessor software update
to the UXS system.  The system administrator should verify the accuracy of
this file as part of the upgrade process.

Configuration The default state of the inetd.sec file is set to “deny” for all entries.  The file
should be modified using the HP-UX SAM utility to allow remote access
for various system services.

Step Action

1 Select System Configuration from the workspace menu.

2 Type the coprocessor (root) password and <RETURN> at the prompt.

Note:  Only <RETURN> is necessary on a new station.

3 Note:  Use the mouse/trackball (double click) or the arrow keys and
<RETURN> to make selections.

Select Networking/Communications.

4 Select Security.

5 Select Internet Service.

6 Using the mouse/trackball pointer select Actions->Modify All
Services from the top of the window.

WARNING This enables ALL services for ALL devices anywhere
on the network.  This can be a security risk.  Instead, you may want to
consider:
a. Select the service you wish to modify (enable).
b. Select Actions->Modify.
c. Select Selected-Allowed.
d. Enter systems to be allowed to use this service.
e. Select the Add button.
e. Skip the next step

7 Select the Allowed button.

8 Select the OK button.

9 Using the mouse/trackball pointer select File->Exit from the top of
the window.

10 Select Exit SAM.
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5.10 Configure Coprocessor Printer (Network)

Local printer install This procedure will configure a coprocessor network printer. The printer
will be available to be configured on other Universal StationX stations.

Required access level The procedures must be performed while logged in as “engineer.”  The
coprocessor (root) password is required.

Menu appearance

51140

Engineer Menu

Window Menu      >

X Manager Menu   >

Application Menu >

System Menu      >

Configuration

IWSM Configuration ...

System Configuration ...

System Terminal ...

Set Time/Timezone ...

System Commands

Configuration    >

Update Software  >

Add/Remove Users ...

Backup/Restore ...

Configure laser printer Configure the coprocessor laser printer using the following procedure:

Step Action

1 Select System Menu ->Configuration ->System Terminal
from the workspace menu.

2 Enter the coprocessor (root) password and press <RETURN>.

3 Insert the Jet Admin Utility tape in the DAT drive.

4 Enter cd /usr/lib and press <RETURN>.

Continued on next page
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5.10 Configure Coprocessor Printer (Network),  Continued

Configure laser printer,
continued

Step Action

5 The procedure to load files from the tape depends on whether or not
the UXS has a local DAT drive.  If the UXS has a local DAT, follow
procedure LOCAL, then continue with the next step.  If the UXS
does NOT have a local DAT, follow procedure REMOTE, then
continue with the next step.

LOCAL If your tape is a tar format:
a. Enter tar xv and press <RETURN>.
b. When the tape load is complete, enter 

/usr/bin/hpnpinstall and press <RETURN>.
c. Enter 1 (Install JetAdmin) and press <RETURN>.
d. Enter Y (to continue the Installation) and press <RETURN>.
e. Press <RETURN> to accept the default directory for 

JetAdmin (/usr/lib).

If your tape is an update format:
a. Enter /bin/ksh and press <RETURN>.
b. Enter export UPDATETAPEMARKS=2 and press 

<RETURN>.
c. Enter /etc/update and press <RETURN>.
d. Use the arrow keys to select Change Source or 

Destination and press <RETURN>.
e. Use the arrow keys to select From Tape Device to 

Local System and press <RETURN>.
f. Check the following entries:

major number: 54
select code: 0
bus address: 1
unit number: 0
volume number: 2

IF these are correct:
Use the mouse/trackball to select Done at the 
bottom of the window.

IF these are NOT correct:
Position the cursor over the n.
Enter y.
Enter the numbers given earlier in this step.
Use the mouse/trackball to select Done at the 
bottom of the window.
Use the mouse/trackball to select Done at the 
bottom of the window (again).

g. Use the arrow keys to select Select All Filesets on
the Source Media and press <RETURN>.

h Use the arrow keys to select Start loading Now and 
press <RETURN>.

i. Enter y.
j. When the tape load is complete, enter exit and press 

<RETURN>.

Continued on next page
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5.10 Configure Coprocessor Printer (Network),  Continued

Configure laser printer,
continued

Step Action

REMOTE If your tape is a tar format:

Note:  Before performing this (remote/tar) procedure, you must
have previously performed the local/tar procedure on another UXS.
Through the remainder of this procedure, that other UXS will be
referred to as “uxswithdat”.  When you perform this procedure,
replace “uxswithdat” with the name of your UXS with the local DAT
drive.

a. Enter ftp uxswithdat and press <RETURN>.
b. Enter the login name (use root) and password.
c. Enter cd /usr/lib and press <RETURN>.
d. Enter get 700-90.tar and press <RETURN>.
e. Enter cd /usr/bin and press <RETURN>.
f. Enter lcd /usr/bin and press <RETURN>.
g. Enter get hpnpinstall and press <RETURN>.
h. Enter quit and press <RETURN>.
i. Enter chmod 550 /usr/bin/hpnpinstall and press

<RETURN>.
j. When the tape load is complete, enter 

/usr/bin/hpnpinstall and press <RETURN>.
k. Enter 1 (Install JetAdmin) and press <RETURN>.
l. Enter Y (to continue the Installation) and press 

<RETURN>.
m. Press <RETURN> to accept the default directory for 

JetAdmin (/usr/lib).

If your tape is an update format:

Note:  This procedure will refer to the UXS with the DAT drive as
“uxswithdat”.  When you perform this procedure, replace
“uxswithdat” with the name of your UXS with the local DAT drive.

a. Set up uxswithdat to be a network distribution (netdist)
server.  To do this, follow the procedure “Preparing S/W Update
Server (Server Only) in this manual.  Use the Jet Admin Utility tape.
b. Load the Jet Admin Utility software from the netdist server
(uxswithdat) to the hard drive of this station.  To do this, follow the
procedure “Remote Coprocessor S/W Update” procedure in this
manual.

Continued on next page
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5.10 Configure Coprocessor Printer (Network),  Continued

Configure laser printer,
continued

Step Action

6 Run the self test on the printer (Use the buttons on the printer's front
panel)

a. Press <ON LINE> (If required) to put the printer off-line.
b. Press <MENU> repeatedly until "TEST MENU" appears on 

the printer panel.
c. Press <ITEM> until "SELF TEST" appears on the printer 

panel.
d. Press <ENTER>.
e. Wait until the self test print is complete.
f. Press <ON LINE> to put the printer on-line.

Note:  The LAN HW ADDRESS on this printout will be used later in
this procedure.

7 Enter /usr/lib/hpnp/jetadmin and press <RETURN>.

8 Note:  Steps 8-11 only need to be performed if you want this UXS to
be a bootp server for the printer.  You need to have at least one
bootp server; you may have more than one.  If you do not want this
UXS to be a bootp server for the printer, skip to step 12.

Add entry for bootp server:

a. If the printer is powered on, turn it off.
b. Enter 1 (configuration - Main Menu) and press <RETURN>.
c. Enter 1 (create printer configuration in BOOTP/TFTP 

database - Configuration Menu) and press <RETURN>.
d. Enter the printer’s LAN hardware address: (ex: 

0800094b53e5) and press <RETURN>.

Note:  Get this address from the printer self test you printed in a
previous step.

e. Enter the network printer name/IP name: (ex: lasernode) and 
press <RETURN>.

f. If prompted, enter the IP address: (ex: 164.145.230.46) and 
press <RETURN>.

If you get a message asking if you want to add your printer to
/etc/hosts, enter y and press <RETURN>.

g. Enter 0 (to configure the printer) and press <RETURN>.

9 Verify that the bootp server configures the printer:

a. Turn the printer power on.
b. Wait until the printer finishes the self test.
c. At the UXS, press <RETURN> to continue.

Continued on next page



4/96 R200 Universal StationX System Administration 67

5.10 Configure Coprocessor Printer (Network),  Continued

Configure laser printer,
continued

Step Action

10 Test the printer by printing a file to it:

a. Enter Y (to send test file(s) to this printer) and press 
<RETURN>.

b. Enter 1 (text file) and press <RETURN>.
c. Press <RETURN> to continue.

11 Get back to the Main Menu:

a Enter q and press <RETURN>.

12 Add the printer (as the default printer) to the system:

a. Enter 1 (configuration - Main Menu) and press <RETURN>.
b. Enter 3 (add printer to local spooler - Configuration Menu) 

and press <RETURN>.
c. Enter the printer host name: (ex: lasernode) and press 

<RETURN>.
d. Enter 1 (LP destination (queue) name - Configurable 

Parameters List) and press <RETURN>.
e. Enter the name of printer: (ex: lasernet) and press 

<RETURN>.
Note:  You may want to use the printer host name as the printer
(peripheral) name.

f. Enter 9 (default queue - Configurable Parameters List) and 
press <RETURN>.

g. Enter 0 (to configure the printer) and press <RETURN>.
h. Press <RETURN> to continue.
i. Press <RETURN> to continue (again).

13 Exit jetadmin

a. Enter q (Quit - Configuration Menu) and press <RETURN>.
b. Enter q (Quit - Main Menu) and press <RETURN>.

14 Enter /usr/lib/lpsched and press <RETURN>.

15 Enter exit and press <RETURN>.

16 Remove the Jet Admin utility software tape from the DAT drive.



68 R200 Universal StationX System Administration 4/96

5.11 Industrial Workspace Manager (IWSM) Configuration

Required access level The user must have engineer group access and perform these procedures
while logged in as “engineer.”  The coprocessor (root) password is
required.

Menu appearance
  Engineer Menu

Window Menu      >

X Manager Menu   >

Application Menu >

System Menu      >   System Commands

Configuration     >

Update Software   >

Add/Remove Users...

Backup/Restore...  

   Configuration

IWSM Configuration ...  

System Configuration ...

Set Time/Timezone ...   

51151

IWSM configuration tool

51152

Display Area Lists 
Co-processor Users 
Allowed to Perform the 
Action Selected Above

IWSM Configuration

Enter Native Mode

Shutdown the WSI

*ALL*           root
*ALL*           operator
*ALL*           engineer
*ALL*           username

Add Delete Close

Text Entry Area

Where username is replaced with user_login_name

Continued on next page
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5.11 IWSM Configuration,  Continued

Shutdown WSI
authorization

Use the following procedure to authorize specific users to shutdown the
coprocessor:

Step Action

1 Select IWSM Configuration from the workspace menu.

2 Type the coprocessor (root) password and <RETURN> at the prompt.

3 Select the Shutdown the WSI target.

4 Select the text entry area of the IWSM Configuration Tool.  (Just
above the Add, Delete, and Close targets).

5 Type information using this syntax:

*ALL* username
where username = user’s login name

Important:
Use spaces to separate  *ALL*  from the user name.

6 Click on the Add target to authorize the user to shut down the WSI.

7 Repeat Steps 4 through 6 for each user requiring shutdown
privileges.

8 Select the Close target.

Remove Shutdown WSI
authorization

Use the following procedure to remove authorization to shut down the
coprocessor from specific users:

Step Action

1 Select IWSM Configuration from the workspace menu.

2 Type the coprocessor (root) password and <RETURN> at the prompt.

3 Select the Shutdown the WSI target.

4 Select the user name to be deleted.

5 Select the Delete target.

6 Repeat Steps 4 and 5 for all users to be deleted.

7 Select the Close target.
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Section 6 – Coprocessor User Environment Configuration

6.1 User Configuration Overview

Coprocessor
configuration

The major difference, when compared to a Universal Station, is the
Universal StationX's ability to display non-TDC 3000X applications,
generated by LAN (Local Area Network - Ethernet) computing resources.

There are several attributes new to the Universal StationX display, which
are necessitated by viewing in the X Windows environment:

• X Host Authorization—Controls remote access to the Universal StationX

display

• Native Window Behavior—Controls dominance of the LCN display

• Keyboard Focus Policy—Controls keyboard/mouse pointer interaction

Custom configuration The Universal StationX coprocessor configuration can be customized to
alter the standard user environment. This could include:

• Providing custom workspace menu choices

• Altering shell variables (path, terminal, prompt, etc.)

• Automatically mounting remote filesystems (HP LaserRom)

• Automatically running applications at login

Customizing the files which control the coprocessor environment should be
done prior to registering users. When the customization is completed, the
users can be registered and additional systems loaded with the custom
configuration.

Required information The following information is required for configuration:

• The hostnames of any remote computing resources which will open an X
display on this station. This access is granted on a user-by-user basis
using subsection 6.2,” X Host Authorization.”
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6.2 X Host Authorization

What is it? The X host authorization application grants X display permission to remote
systems on an individual-user basis. This allows other computer systems to
open a window on the user's Universal StationX display.

Required access level The procedures can be performed by any authorized user. This
authorization is granted/recorded on an individual-user basis.

Menu appearance Engineer Menu

Window Menu      >

X Manager Menu   >

Application Menu >

System Menu      >    X Manager Menu

X Host Authorization   

Change User Password   

Refresh                

Restart ...            

Logout ...     
51153

X Host tool

Display Area Lists 
Hostnames Authorized to 
Send an X-Window Display 
to This Station.

51017

X Host Authorization

Only the listed hosts are allowed access

Any host is allowed access

hostname 1
hostname 2
hostname 3

Add Delete Close

Text Entry Area

X host addresses To authorize remote systems to display X Window applications on the
Universal StationX, the hostname and TCP/IP address must be entered prior
to this step, using the LAN information entry procedure.

Continued on next page



4/96 R200 Universal StationX System Administration 73

6.2 X Host Authorization,  Continued

X host authorization
scope

The user can choose from two methods of granting access permission:

• Explicit host authorization—user must enter the hostnames of all systems
requiring access

• Grant access to all hosts—user selects Any host is allowed access

Explicit host
authorization

Use the following to authorize specific X hosts access:

Step Action

1 Select X Host Authorization from the workspace menu.

2 Type the coprocessor (root) password and <RETURN> at the prompt.

3 Select Only the listed hosts are allowed access target.

4 Click on the text entry area of the IWSM Configuration Tool.

5 Type information using this syntax:

hostname
hostname
hostname
hostname
hostname = replace with a valid hostname

Use of spaces is not allowed. The tool does nothing if there are
invalid characters in the text entry field.

6 Click on the Add target to authorize the remote host to display locally.

7 Repeat Steps 4 through 6 for each host requiring X host access.

8 To delete a host’s X display authorization privileges, click on the
hostname to be deleted.

9 Click on the Delete target.

10 Repeat Steps 8 and 9 for each host to be deleted.

11 Select the Close target.

Continued on next page
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6.2 X Host Authorization,  Continued

Allowing all X-hosts
access

All LAN computing resources listed in the hosts file can be authorized to
display X-window applications on this station using the following
procedure.

Step Action

1 Select X Host Authorization from the workspace menu.

2 Type the coprocessor (root) password and <RETURN> at the prompt.

3 Select the Any host is allowed access target.

4 Select the Close target.

Display Area Lists 
Hostnames Authorized 
to Send an X-Window 
Display to This Station.

51145

X Host Authorization

Only the listed hosts are allowed access

Any host is allowed access

hostname 
hostname 
hostname 

Add Delete Close

Text Entry Area
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6.3 Configure Native Window Behavior

Window dominance The dominance of the Native LCN Window is configurable on a user-by-
user basis. The attribute allows the Native LCN Window to be partially
obscured by another window.

The Native LCN Window behavior is initially configured to allow only
engineering group members to obscure the LCN display. However, the
individual users (all access levels) can set this attribute at their discretion.

Menu appearance

51144

Native LCN Window

Allow Partial Window Overlay
Allow Total Window Overlay
ZoomTouch Active un Full Screen Mode
Automatic Resize

Size  Options

Allow/Disallow partial
window overlay

The selection of this option toggles on/off.  Therefore, perform the same
steps to allow partial window overlay and to disallow partial window
overlay.

Step Action

1 Select Options from the Native LCN Window menu bar.

Note:  If a square appears to the left of the Allow Partial Window
Overlay option, it indicates that the option is currently allowed.  This
will allow the Native LCN Window to be partially obscured by another
window.
If no square appears to the left of the Allow Partial Window Overlay
option, it indicates that the option is currently disallowed.  This will not
allow the Native LCN Window to be partially obscured by another
window.

2 Select Allow Partial Window Overlay to change the option.

Note: The change will take effect immediately.

Continued on next page
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6.3 Configure Native Window Behavior,  Continued

Allow/Disallow total
window overlay

The selection of this option toggles on/off.  Therefore, perform the same
steps to allow total window overlay and to disallow total window overlay.

Step Action

1 Select Options from the Native LCN Window menu bar.

Note:  If a square appears to the left of the Allow Total Window
Overlay option, it indicates that the option is currently allowed.  This
will allow the Native LCN Window to be totally obscured by another
window.
If no square appears to the left of the Allow Total Window Overlay
option, it indicates that the option is currently disallowed.  This will not
allow the Native LCN Window to be totally obscured by another
window.

2 Select Allow Total Window Overlay to change the option.

Note: The change will take effect immediately.

Setting default native
window behavior

Default behavior for the Native LCN Window during future login sessions
can be configured for each user.  This is accomplished by modifying the
.Xdefaults file in the individual user’s directory.

To set up the Native LCN window in the operator1 account to allow other
windows to obscure it (partially or totally), change (or add) the following
lines in the .Xdefaults file in operator1’s directory
(/users/XUS/operator/operator1).

NativeLCNWindow*allowTotalObscurity: False
NativeLCNWindow*allowPartialObscurity: True

To set up the Native LCN window in the operator1 account to automatically
resize the LCN display to the current window size, change (or add) the
following line in the .Xdefaults file in operator1’s directory
(/users/XUS/operator/operator1).

NativeLCNWindow*autoZoom: True

Global Native LCN window behavior for all users can be achieved by
changing the lines above in the NativeLCNWindow file in the
/usr/lib/X11/app-defaults directory.
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6.4 Configure Keyboard Focus Policy

Required access level The procedure can be performed while logged in as any user.

Menu appearance

51154

Explicit

Pointer

Operator Menu

Window Menu      >

X Manager Menu   >

Application Menu >

Window Menu

Shuffle               >

Other Screen           

Keyboard Focus Policy >

Window Print           

Explicit vs. Pointer The keyboard focus policy allows two choices:

• Explicit focus—user must click on a window to make it active

• Pointer focus—user must point at the window to make it active

Note: Even small mouse movements may inactivate the window
when using pointer focus. This may cause keyboard entries to
be lost or directed to the wrong window.

Explicit focus Use the following to set the focus policy to explicit:

Step Action

1 Select Keyboard Focus Policy - Explicit from the
workspace menu.

Note: The change in focus policy will not take effect until the next 
login.

Pointer focus Use the following to set the focus policy to pointer:

Step Action

1 Select Keyboard Focus Policy - Pointer from the workspace
menu.

Note: The change in focus policy will not take effect until the next 
login.
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6.5 Change User Password

Required access level The procedure can be performed while logged in as any user.  The current
password is required.

Menu appearance Operator Menu

Window Menu      >

X Manager Menu   >

Application Menu >    X Manager Menu

X Host Authorization   

Change User Password   

Refresh                

Restart ...            

Logout ...     
51155

Change the
user password

Change the user password frequently to ensure security.

Step Action

1 Select Change User Password from the workspace menu.

2 Type the old password and <RETURN> at the prompt.

Note: The new password must be at least 6 characters, containing
at least 2 alpha characters and 1 numeric character.

3 Type a new password and <RETURN>.

4 Retype the new password and <RETURN> to confirm the entry.
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6.6 Customizing the Workspace Menu

Why customize? The workspace menu can contain items which connect to and run
application software on remote systems and cause them to display locally.
This reduces the steps and knowledge required to perform an operational
task.

Modify all users By modifying the file in the appropriate .baseUser directory, the
customization can be for all subsequently registered users of a specific
group. Remember to transfer this file to the .baseUser directory on all
machines.

To use the new custom menu, prior users must have the new file transferred
to their home directory.

Modify a single user By modifying the .mwmrc file in the user’s home directory, only that user
will have the altered workspace menu. Remember to transfer this file to the
user’s home directory on all machines where he is registered.

Appropriate files A customized command string can be appended to the workspace menu by
placing the command string into the appropriate .mwmrc file.

• /users/XUS/operator/.baseUser/.mwmrc

• /users/XUS/operator/username/.mwmrc

• /users/XUS/supervisor/.baseUser/.mwmrc

• /users/XUS/supervisor/username/.mwmrc

• /users/XUS/engineer/.baseUser/.mwmrc

• /users/XUS/engineer/username/.mwmrc

• /users/XUS/viewOnly/.baseUser/.mwmrc

• /users/XUS/viewOnly/username/.mwmrc

Parts of a command
string

There are several components of a workspace menu command string to be
placed into the .mwmrc file. The elements of the string are the same for all
remote computing systems (even those of dissimilar operating systems).
However, the commands and syntax of the remote system are used in one
element of the command string. This requires knowledge of the remote
operating systems commands and operation. This knowledge will not be
covered in this manual and can be located in the documentation of the
appropriate system.

Continued on next page
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6.6 Customizing the Workspace Menu,  Continued

Parts of a command
string, continued

The elements of the workspace menu command strings:

Menu RootMenu
{
"Engineer Menu"     f.title
"X Menu"            f.menu   XMenu
"Application Menu"  f.menu   ApplicationMenu
"System Menu"       f.menu   SystemMenu
}
Menu XMenu
{
"X Menu"            f.title
"Shuffle"           f.menu   ShuffleMenu
"Logout"            f.quit_mwm
}
Menu ApplicationMenu
{
"Applications"      f.title              
"Unix Load"         f.exec "xload-geom -4+4 &"
"Calculator"        f.exec "xcalc -geom -160+4 &"
"Datebook"          f.exec "datebook -geom +724+4 &"
"Telnet"            f.exec "xterm -geom +291+400 -e telnet &"
"DecNet"            f.exec "xteemx340 -geom +291+400 &"
}

MENU ITEM NAMES WINDOW  MANAGER COMMANDS

SYSTEM COMMANDS

12605

Creating a command To create the command line, use the vi text editor to modify the appropriate
.mwmrc file. Here are the steps to creating a command string to be included
in the workspace menu.

Step Action

1 Choose a menu label.

2 Choose the appropriate window manager command.

3 Determine if a remote shell is necessary. It is required to execute
applications on remote computers.

4 Choose the system command including any additional parameters as
appropriate to the software application.

Continued on next page
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6.6 Customizing the Workspace Menu,  Continued

Choosing a label Choose a label name that represents the action as close as possible. Time
spent planning will provide a menu system that is intuitive and requires little
(if any) additional documentation.

Choose a window
manager command

Several window manager commands are used to customize the workspace
menu and are listed here for your convenience. For additional information,
see Hewlett Packard publication, Using the X Window System.

Category Command Description

Program
Execution

f.exec “cmd &” Executes cmd using /bin/sh

f.restart Restarts the Motif Window Manager

f.kill Kills the client that started the window

Menu
Operations

f.menu MenuName Associates a menu with a selection

f.post_wmenu Posts a window menu

f.separator Draws a line between selections

f.title Inserts a title into menu at specified
position

f.nop Disable a menu entry with no operation

Local commands To execute commands on the local system, only the window manager
command and system command are necessary.

Required syntax for executing local applications
“MenuItemName”    f.exec “ApplicationName &”
“MenuItemName”    f.exec “ScriptFileName &”

An example of the command string to execute a local application.
“Datebook”    f.exec  “datebook &”

Continued on next page
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6.6 Customizing the Workspace Menu,  Continued

Remote commands To execute commands in a remote computer system, a remote shell session
is needed. Add the following to the window manager command to build the
command string.

Required syntax for executing remote applications
“MenuItemName”    f.exec “remsh hostname ApplicationName &”
“MenuItemName”    f.exec “remsh hostname ScriptFileName &”

An example of the command string to execute the application Framemaker
on the host system named hp7ØØ_Ø1.
“Word Processor”    f.exec  “remsh hp7ØØ_Ø1 maker &”

Sample customization The following is an example of the existing Application Menu customized to
provide an automatic connection to remote computers running various
software. It is an excerpt of the standard .mwmrc file with additional lines
(shown in larger print) to produce the workspace menu changes.

Menu ApplicationMenu

{

"Applications"    f.title

"Unix Load"       f.exec "xload -geom -4+4 &"

"Calculator"      f.exec "xcalc -geom -160+4 &"

"Datebook"        f.exec "datebook -geom +724+4 &"

"Telnet"          f.exec "xterm -geom +291+400 -e telnet &"

"DECnet"          f.exec "xteemx340 -geom +291+400 &"

"Lab Analysis"    f.menu LabMenu

}

Menu LabMenu

{

"Lab Analysis"    f.title

"Inlet PH"        f.exec "remsh hp700_01 -l Inlet_PH raw1 &"

"Inlet Temp"      f.exec "remsh hp700_02 -l Inlet_Temp raw2 &"

"Inlet PPM"       f.exec "remsh vax01 -l Inlet_Clarity raw3 &"

"Discharge PH"    f.exec "remsh hp700_2 -l Waste_PH out1 &

"Discharge Temp"  f.exec "remsh hp700_2 -l Waste_Temp out2 &

"Discharge PPM"   f.exec "remsh vax01 -l Waste_Clarity out3 &

"Reports"         f.menu ReportMenu

}

Menu ReportMenu

"Reports"           f.title

"Shift Summary"     f.exec "RunShiftSum &"

"Daily Summary"     f.exec "RunDailySum &"

"Weekly Summary"    f.exec "RunWeekSum &"

}

Continued on next page
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6.6 Customizing the Workspace Menu,  Continued

Sample customization,
continuation

Produces the following Applications Menu with two new sub menus:

Reports Menu

Shift Summary

Daily Summary

Weekly Summary

Applications

Unix Load

Calculator

Datebook

Telnet

DecNet

Lab Analysis   > Lab Analysis

Inlet PH

Inlet Temp

Inlet PPM

Discharge PH

Discharge Temp

Discharge PPM

Reports     >

12607
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6.7 Customizing the User’s Shell Variables

What is the shell? The shell is the mechanism used to issue commands to the UNIX
processor. This shell acts as a command interpreter and controls the UNIX
system resources to carry out the requested task. The shell provides a
powerful and flexible programming language to allow creation of script files
containing many commands.

Available shells There are several shells used

• /bin/ksh — Korn shell used for members of the group Engineer

• /bin/rksh — restricted Korn shell used for members of the groups:
Operator, Supervisor, and View Only

• /bin/csh — C shell used for the root user

Shell variables The shell tracks items called variables that it uses to control system
resources.

The most often used variables are

• SHELL - Pathname of your shell

• TERM - Defines your terminal type for screen oriented commands

• PATH - List of directories the shell searches for commands

Controlling files The shell variables are set at login and each time a shell is created. The
system executes various initialization files depending on the users shell
type. These files are located in the users home directory.

Shell type Controlling files

Korn shell — /bin/ksh .profile — executed at login
$ENV — when a subshell is spawned

Note: $ENV is a variable that defines
the name of the file.  Commonly .kshrc

Restricted Korn shell — /bin/rksh .profile — executed at login
$ENV — when a subshell is spawned

C shell — /bin/csh .login — executed at login
.cshrc —when a subshell is spawned

For more information For more information, see the following Hewlett Packard publications:

• A Beginners Guide To Using Shells

• HP-UX Concepts and Tutorials: Shells and Miscellaneous Tools

• HP-UX System Security
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Section 7 – Coprocessor Administration Tasks

7.1 Create New Coprocessor Users

Required access level The procedures must be performed while logged in as “engineer.”  The
coprocessor (root) password is not required.

Guidelines Use the following criteria when adding a user to the coprocessor
environment:
• Assign a separate login name for each user

• Do not assign a login name beginning with a number

• Determine the user’s group access level by providing the “least
privileges” necessary to perform the required tasks

• Do keep a record of all users assigned access, it should contain:

– User name, contact information (phone number, address, etc.)

– User login name

– User access level

– List all systems the user has accounts on

– List all software where the user has accounts (E-mail, Telex, etc.)

Note: This listing should be maintained by the system administrator.

Trusted Systems WARNING     Honeywell strongly recommends that you do not make your
Universal StationXs trusted systems.

The coprocessor user environment is not intended to be used to configure a
secure (trusted) system.  If a trusted system configuration is required, use
the HP-UX System Administration Manager (SAM) utility for this purpose.
Refer to the manual “HP-UX System Security” for further information on
setting up a trusted system.

.baseUser files The .baseUser directory in each user category (engineer, operator, etc.)
contains the default files that will be used to initially configure a new user’s
own directory.  Be aware that Honeywell may update these files during a
software release upgrade procedure.  If you choose to modify any of these
files, be sure to create a backup copy.  Your custom changes should be
merged back in with the new updated file after the software update is
complete

Continued on next page
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7.1 Create New Coprocessor Users,  Continued

Initial use When new users are created, the password is set equal to the login name.
For example:  the user account “guest” will use the password “guest.”

To maintain system security, it is important that the password be changed as
soon as practical. To do this, login as the new user and select change
password from the workspace menu. Enter a password and record this
information for the new user.

Menu appearance Engineer Menu

Window Menu      >

X Manager Menu   >

Application Menu >

System Menu      >   System Commands

Configuration     >

Update Software   >

Add/Remove Users...

Backup/Restore...  
51157

Add users Use the following procedure to configure user access to the coprocessor.
Note: If, at any point in the following instructions, you have made an

error, selecting the Close target without selecting Apply will
exit without saving changes.

Step Action

1 Select Add/Remove Users... from the workspace menu, it is
found nested  as System Menu > Add/Remove Users.

2 Select the User target.

3 Select the Add target.

4 Type the user-login name in the Login Name field.

5 Type full user name, office location, work and home phone number
into the field provided.

6 Select the appropriate group target from the menu.

7 Select the Apply target to save changes.

8 Repeat Steps 4 through 7 for each user.

Continued on next page
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7.1 Create New Coprocessor Users,  Continued

Add users, continued

9 Select the CLOSE target and the window will close.

10 Select the Apply target to save changes.

11 Select the OK target.

12 Select the CLOSE target and the window will close.

13 Select the Exit Xsam target.

14 Select the OK target.
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7.2 Delete Coprocessor Users

Required access level The procedures must be performed while logged in as “engineer.”  The
coprocessor (root) password is not required.

Menu appearance Engineer Menu

Window Menu      >

X Manager Menu   >

Application Menu >

System Menu      >   System Commands

Configuration     >

Update Software   >

Add/Remove Users...

Backup/Restore...  
51157

Delete users To deny authorized users access to the coprocessor, use the following:
Note: If at any point in the following instructions you have made an

error, selecting the Close target without selecting Apply will
exit without saving changes.

Step Action

1 Select Add/Remove Users... from the workspace menu.

2 Select the User target.

3 Select each user to be removed by selecting the icon to left of the
user-login name.

Note:  The icon is highlighted to show selection.

4 Select the Remove target.

5 Select the OK target.

Note:  This step is required only if multiple users have been selected
to be removed.

6 Select the Apply target to save changes.

7 Select the OK target.

8 Select the Close target and the window will close.

9 Select the Exit Xsam target in the lower right corner.

10 Select the OK target.
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7.3 Modify Coprocessor User Information

Required access level The procedures must be performed while logged in as “engineer.”  The
coprocessor (root) password is not required.

Menu appearance Engineer Menu

Window Menu      >

X Manager Menu   >

Application Menu >

System Menu      >   System Commands

Configuration     >

Update Software   >

Add/Remove Users...

Backup/Restore...  
51157

Modify user information To modify a user’s coprocessor access information, use the following.
Note: If, at any point in the following instructions, you have made an

error, selecting the Close target without selecting Apply will
exit without saving changes.

Step Action

1 Select Add/Remove Users... from the root menu.

2 Select the User target.

3 Select the user (to modify) by clicking on the icon to the left of the
user-login name. Note: icon is highlighted to show selection.

4 If applicable, type changes into the Login ID field.

5 If applicable, type changes into the full name field.

6 To change the access level, select a group target.

7 Repeat Steps 4 through 7 for each user to be modified.

8 Select the Apply target to save changes.

9 Select the Close target and the window will close.

10 Select the Exit Xsam target and the window will close.

11 Select the OK target.
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7.4 Backup the Local Coprocessor Hard Drive

Two Options There are several ways to backup and restore the data on the hard drive.
Two options will be discussed here.  One option is to use the
Backup/Restore menu selection, the other is to enter a command from a
terminal connected to the WSI2 I/O board.  Both perform the same type of
backup (fbackup); however, the “menu option” allows other functions to be
performed on the Universal StationX while the backup is running (e.g.,
someone can be using the Native LCN Window to control the process).
The “terminal option” does not allow other functions to be performed on the
Universal StationX while the backup is running.  The terminal option, on
the other hand, runs in “single-user mode,” which allows a more error free
backup.  The menu option usually has a few block checksum mismatch
errors.  A backup with these errors can still be used to restore the files on
the hard drive, but there will be a few files that cannot be restored because
of the errors.  The terminal option is the preferred method if the station can
be “down” during the backup.  The backup procedure takes about 45-60
minutes.  You must weigh the options and decide which is the better option
in your situation.

Required access level The menu option procedure must be performed while logged in as
“engineer”, and does not require the coprocessor (root) password.  The
terminal option does not require (or allow) login from the login banner, but
does require the coprocessor (root) password.

Menu appearance Engineer Menu

Window Menu      >

X Manager Menu   >

Application Menu >

System Menu      >   System Commands

Configuration     >

Update Software   >

Add/Remove Users...

Backup/Restore...  
51158

Continued on next page
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7.4 Backup the Local Coprocessor Hard Drive,  Continued

Menu Option Use the following procedure to backup the local coprocessor hard drive
using the menu option.
Note: This procedure currently performs only full backups. The

contents of the DAT tape will be overwritten.

Step Action

1 Gently Insert the tape into the DAT drive.

If you are unable to successfully insert the tape, gently remove the
cartridge and reinsert it again. If you are still unsuccessful, contact
your Honeywell service representative for assistance.

2 Select System Menu->Backup/Restore from the workspace
menu.

3 Select the Backup target.

4 To perform a backup of the entire Universal StationX filesystem

Select the System(all files) target

Note: Generally, this is a better choice than only backing up user files.

To perform a backup of Universal StationX user files only

Select the User files only target.

5 To perform a FULL backup of all files within the scope

Select the FULL (all files)  target.

Note:  Performing an incremental backup is a feature that is not
available at this time.

6 Select the appropriate host target.  This indicates which device will
have the tape drive.

7 Select the Start Backup  target.

Note: Depending on your selection (system or user backup), the
backup operation will take 2 to 60 minutes to complete.

8 Upon completion, the following message is displayed:

fbackup:  runtime:  2038 Seconds
End of Execution

9 Select the Close target.

10 Select the Exit Xsam target.

Click on OK at the message Do you really want to exit?

11 Remove the backup tape from the DAT drive.

Continued on next page
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7.4 Backup the Local Coprocessor Hard Drive,  Continued

Terminal Option Use the following procedure to backup the local coprocessor hard drive
using the terminal option.
Note: This procedure, as written, performs full backups. The contents

of the DAT tape will be overwritten.  If you wish to perform
incremental backups, you will need to become more familiar
with the fbackup command.  Use the documentation distributed
with the Universal StationX  (on CD/ROM) to learn more about
fbackup.

Step Action

1 Gently Insert the tape into the DAT drive.

If you are unable to successfully insert the tape, gently remove the
cartridge and reinsert it again. If you are still unsuccessful, contact
your Honeywell service representative for assistance.

2 Connect a vt100 terminal to the WSI2 I/O board of the UXS.

3 Press <RETURN> (to get a login prompt), and login as root

4 Put the UXS in single user mode by entering shutdown -y 0
(zero) and pressing <RETURN>.

Note:  This will take about 30 seconds.

5 Enter /etc/fbackup -i / -f /dev/rmt/0m (zero-em) and
press <RETURN>.

Note:  This command performs a backup of the entire UXS filesystem;
it is the recommended command.  However, if you prefer to backup
only a portion of the system, you can specify a directory to be backed
up following the “-i” option.  Example:

/etc/fbackup -i /users/XUS -f /dev/rmt/0m

This will backup only the files under the /users/XUS directory (and all
of it’s subdirectories).  This is equivalent to selecting a User backup
when using the Menu Option.

Note: Depending on the directories you are backing up (/ or
/users/XUS), the backup operation will take 2 to 60 minutes to
complete.

6 After the backup completes, remove the backup tape from the DAT
drive.

7 Enter reboot -q and press <RETURN>.

8 Disconnect the vt100 terminal from the WSI2 I/O board of the UXS.
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7.5 Restore Local Coprocessor Hard Drive Data

Required access level The procedures must be performed while logged in as “engineer.”  The
coprocessor (root) password is not required.

Menu appearance Engineer Menu

Window Menu      >

X Manager Menu   >

Application Menu >

System Menu      >   System Commands

Configuration     >

Update Software   >

Add/Remove Users...

Backup/Restore...  
51158

Coprocessor restore
menu

This menu provides the mechanism necessary to restore the coprocessor
filesystem from a prior backup tape. It allows the user to specify the
process by which files are restored.

Restore types The restore procedure allows two types of file restoration:

• Overwrite — restores tape contents to the Universal StationX regardless
of time stamp.

• Update — writes files with dates later than those present in the Universal
StationX.

Perform a restore To perform a restore, follow this procedure:
Note: If, at any point in the following instructions, you have made an

error, select the EXIT RESTORE target to exit.

Step Action

1 Remove the appropriate tape from its protective case and gently
insert it into the tape drive. Press gently on the edge of the tape
cartridge while inserting it into the unit until you feel the unit pull on
the tape. The unit will then load and position the tape. While
positioning is being performed, both indicator lamps on the front of
the unit will flash. When the right lamp shows a solid green,
positioning is complete and the tape unit is ready to use.

If you are unable to successfully insert the tape, gently remove the
cartridge and reinsert it again. If you are still unsuccessful, contact
your Honeywell service representative for assistance.

2 Select Backup/Restore... from  the workspace menu.

Continued on next page
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7.5 Restore Local Coprocessor Hard Drive Data,  Continued

Perform a restore,
continued

Step Action

3 Select the Restore target.

4 To perform an overwrite with all files on the tape

Select the Overwrite target.

WARNING   -  This procedure may cause error messages to
be output during the restore due to conflict with running system
processes.  It is recommended that selective restores be performed
instead of complete restores whenever feasible.

To perform an update with files from the tape

Select the Update target.

5 Select the Start Restore target.

6 Select the Close target.

7 Select the Exit Xsam target.

Click on OK at the message Do you really want to exit?
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7.6 Backup a Remote Coprocessor Hard Drive

Why this procedure? This procedure will backup the hard drive that is on a remote coprocessor.
That coprocessor can be another Universal StationX, an Application
ModuleX, or a Hewlett Packard 712/60 workstation.  The remote device
can also be any other device that has the HP-UX 9.05 operating system.

You would use this procedure if the remote device is an Application
ModuleX, or a Hewlett Packard 712/60 workstation that does not have a
DAT drive.  If the remote device is a Universal StationX, either this
procedure or the Backup the Local Coprocessor Hard Drive procedure
could be used.  In the case of the Universal StationX, the only difference is
whether you will be performing the procedure from the Universal StationX

with the hard drive (the other procedure), or from the Universal StationX
with the DAT drive (this procedure).

The backup procedure takes about 45-60 minutes.

Required access level This procedure must be performed while logged in as “engineer”, and
requires the coprocessor (root) password.

Menu appearance

51140

Engineer Menu

Window Menu      >

X Manager Menu   >

Application Menu >

System Menu      >

Configuration

IWSM Configuration ...

System Configuration ...

System Terminal ...

Set Time/Timezone ...

System Commands

Configuration    >

Update Software  >

Add/Remove Users ...

Backup/Restore ...

Continued on next page
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7.6 Backup a Remote Coprocessor Hard Drive,  Continued

Backup Procedure Use the following procedure to backup a remote coprocessor hard drive to
the DAT drive on the local Universal StationX.

Note: This procedure, as written, performs full backups. The contents
of the DAT tape will be overwritten.  If you wish to perform
incremental backups, you will need to become more familiar
with the fbackup command.  Use the documentation distributed
with the Universal StationX  (on CD/ROM) to learn more about
fbackup.

Step Action

1 Login as engineer to the UXS with the DAT drive.

2 Gently Insert the tape into the DAT drive.

If you are unable to successfully insert the tape, gently remove the
cartridge and reinsert it again. If you are still unsuccessful, contact
your Honeywell service representative for assistance.

3 Select System Menu->Configuration->System Terminal
from the workspace menu.

4 Enter the coprocessor (root) password for the local UXS and press
<RETURN>.

5 Verify that the name of the remote node is in the /.rhosts file of the
local station .  If it is, go to the next step, if not, follow these
instructions to add it:

a. Enter vi /.rhosts and press <RETURN>.
b. Enter <Shift>g<Shift>a (GA) and press <RETURN>.
c. Enter the full name of the remote node (alias names can not 

be used).
d. Press <ESC>.
e. Enter :wq! and press <RETURN>.

6 Enter rlogin remotehostname  and press <RETURN>.

Note:  remotehostname is the name of the device with the hard drive.

7 If necessary, enter the root password for the remote device and press
<RETURN>.

8 If prompted for TERM (terminal type), enter hpterm and press
<RETURN>.

Continued on next page
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7.6 Backup a Remote Coprocessor Hard Drive,  Continued

Backup Procedure,
continued

Step Action

9 Enter /etc/fbackup -i / -f localhostname:/dev/rmt/0m
(zero-em) and press <RETURN>.

Note:  localhostname  must be a host that is known to the remote
system.

Note:  This command performs a backup of the entire UXS filesystem;
it is the recommended command.  If you prefer to backup only a
portion of the system, however, you can specify a directory to be
backed up following the “-i” option.  Example:

/etc/fbackup -i /users/XUS -f uxs1:/dev/rmt/0m

This will backup only the files under the /users/XUS directory (and all
of it’s subdirectories).

Note: Depending on the directories you are backing up (/ or
/users/XUS), and the size of your hard drive, the backup operation will
take 2 to 60 minutes to complete.

10 After the backup completes, enter exit and press <RETURN>.  This
will log out of the remote node.

11 Remove the backup tape from the tape drive.

12 Log out of the UXS.
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7.7 Restore a Remote Coprocessor Hard Drive

Why this procedure? This procedure will Restore the hard drive that is on a remote coprocessor.
That coprocessor can be another Universal StationX, an Application
ModuleX, or a Hewlett Packard 712/60 workstation.  The remote device
can also be any other device that has the HP-UX 9.05 operating system.

You would use this procedure if the remote device is an Application
ModuleX, or a Hewlett Packard 712/60 workstation that does not have a
DAT drive.  If the remote device is a Universal StationX, either this
procedure or the Restore the Local Coprocessor Hard Drive procedure
could be used.  In the case of the Universal StationX, the only difference is
whether you will be performing the procedure from the Universal StationX

with the hard drive (the other procedure), or from the Universal StationX
with the DAT drive (this procedure).

The Restore procedure takes about 45-60 minutes.

Required access level This procedure must be performed while logged in as “engineer”, and
requires the coprocessor (root) password.

Menu appearance

51140

Engineer Menu

Window Menu      >

X Manager Menu   >

Application Menu >

System Menu      >

Configuration

IWSM Configuration ...

System Configuration ...

System Terminal ...

Set Time/Timezone ...

System Commands

Configuration    >

Update Software  >

Add/Remove Users ...

Backup/Restore ...

Continued on next page
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7.7 Restore a Remote Coprocessor Hard Drive,  Continued

Restore Procedure Use the following procedure to Restore a remote coprocessor hard drive
from the DAT drive on the local Universal StationX.

Note: This procedure, as written, restores all files on the DAT tape.
The contents of the hard drive will be overwritten even if the
files on the DAT are older than the files on the hard drive.  If
you wish to perform selective file restores, you will need to
become more familiar with the frecover command.  Use the
documentation distributed with the Universal StationX  (on
CD/ROM) to learn more about frecover.

Step Action

1 Login as engineer to the UXS with the DAT drive.

2 Gently Insert the tape into the DAT drive.

If you are unable to successfully insert the tape, gently remove the
cartridge and reinsert it again. If you are still unsuccessful, contact
your Honeywell service representative for assistance.

3 Select System Menu->Configuration->System Terminal
from the workspace menu.

4 Verify that the name of the remote node is in the /.rhosts file of the
local station .  If it is, go to the next step, if not, follow these
instructions to add it:

a. Enter vi /.rhosts and press <RETURN>.
b. Enter <Shift>g<Shift>a (GA) and press <RETURN>.
c. Enter the full name of the remote node (alias names can not 

be used).
d. Press <ESC>.
e. Enter :wq! and press <RETURN>.

5 Enter the coprocessor (root) password for the local UXS and press
<RETURN>.

6 Enter rlogin remotehostname  and press <RETURN>.

Note:  remotehostname is the name of the device with the hard drive.

7 If necessary, enter the root password for the remote device and press
<RETURN>.

8 If prompted for TERM (terminal type), enter hpterm and press
<RETURN>.

Continued on next page
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7.7 Restore a Remote Coprocessor Hard Drive,  Continued

Restore Procedure,
continued

Step Action

9 Enter:
/etc/frecover -rov -f localhostname:/dev/rmt/0m
(zero-em) and press <RETURN>.

Note:  localhostname  must be a host that is known to the remote
system.

Note:  This command performs a restore of all the files that are on the
DAT tape, and will overwrite newer files on the hard drive with older
ones from the DAT tape.  If you prefer to Restore only a portion of the
files from the tape, you can specify a “graph file” (which indicates
which files to be restored) following a “-g” option.  Example:

frecover -x -g /tmp/graphfile -f uxs2:/dev/rmt/0m

Examples of entries in graphfile are as follows:

i   /users/XUS
e   /users/XUS/operator
i   /usr/lib/X11
i   /etc/passwd

This will restore (include) all the files under the /users/XUS (except
those in the /users/XUS/operator directory).  It will also restore
(include) all the files under the /usr/lib/X11 directory (and all it’s
subdirectories), and will restore the /etc/passwd file

Note: Depending on the directories you are restoring, and the size
of your hard drive, the Restore operation will take 2 to 60 minutes to
complete.

10 After the Restore completes, enter exit and press <RETURN>.
This will log out of the remote node.

11 Remove the backup tape from the tape drive.

12 Log out of the UXS.
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7.8 Upgrade Instructions- Release 200 to Release 200

Overview Use the following procedure to upgrade an existing Release 200 station to a
newer version of Release 200 software.  The first tape to be loaded will be
the UxS Windows SW (RELEASE 200) tape.  Depending on the update,
there may also be a UxS Personality for UxS R200 tape issued.  This
update procedure will load the two separate DAT tapes and is divided into
two parts:

1. Loading of a single fileset on the UxS Windows SW (RELEASE 200)
tape.

2. Loading the UxS Personality for UxS R200 tape.

ATTENTION The .baseUser directory in each user group (engineer, operator, etc.)
contains the default files that will be used to initially configure a new user’s
own directory.  Be aware that Honeywell may update these files during a
software release upgrade procedure.  If you choose to modify any of these
files, be sure to create a backup copy.  Your custom changes should be
merged back in with the new updated file after the software update is
complete.

The files .Xdefaults, .mwmrc, and .xhosts will not be updated in the
software update process.  Newer versions of the files will be created as
d.Xdefaults.200, d.mwmrc.200, and d.xhosts.200 respectively.  These
new versions should be merged in with their original version before any
new users are added to the system.

Continued on next page
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7.8 Upgrade Instructions - Release 200 to Release 200,  Continued

“UxS Windows SW”
tape load procedure

Step Action

1 Insert the UxS Windows SW (RELEASE 200) tape into the DAT tape
drive.  Wait for the lights to stop blinking.

2 Login as engineer

3 Select Update Software - Local from the workspace menu.

4 Type the coprocessor (root) password and <RETURN> at the prompt.

5 In the update window, use the arrow keys to highlight.

Change Source or Destination ->

then press the <RETURN> key on the keyboard.

This will cause a new window to appear within the update window.

6 In the window that just popped up, use the arrow keys to highlight

From Tape Device to Local System ->

then press the <RETURN> key on the keyboard.

This will cause a new window to appear within the update window.

7 In the window that just popped up you will be prompted to change
the parameters in the file /dev/update.src.  The current parameters
are displayed at the right side of the window.  They should appear as
follows:

major number: 54
slot number:   0
bus address:   1
unit number:   0
volume number: 2

If these settings are correct, use the mouse to position the cursor
over the “Done” button at the bottom of the update window and
press the left button on the mouse.  Go on to the next step.

If a change needs to be made, position the cursor over the “n” in the
following question using the arrow keys on the keyboard and type
“y”.

Create or change the address of
/dev/update.src ->

This will cause a new window to appear within the update window.
Make the necessary changes and use the mouse to position the
cursor over the “Done” button at the bottom of the update window
and press the left button on the mouse.  Select the “Done” button a
second time.

Continued on next page
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7.8 Upgrade Instructions - Release 200 to Release 200,  Continued

“UxS Windows SW”
tape load procedure,
continued

Step Action

8 Select Select/View Partitions and Filesets <RETURN>.

9 Locate the line:   HONEYWELL-USX

Enter a Y to the left of that line and select the “Start Loading”
target with the left mouse button.

10 Enter y to Start Loading Filesets Now? (y or n)

Note:  This fileset will take several minutes to be located on the tape.
When the load is complete the system will reboot.

11 Remove the UxS Windows SW (RELEASE 200) tape.

Note:  The UXS will automatically reboot.

Loading the UxS
Personality for UxS
R200 tape

Step Action

1 Insert the UxS Personality for UxS R200 tape into the DAT tape drive.

2 Login as engineer

3 Select Update Software - Local from the workspace menu.

4 Type the coprocessor (root) password and <RETURN> at the prompt.

5 In the update window, use the arrow keys to highlight.

Change Source or Destination ->

then press the <RETURN> key on the keyboard.

This will cause a new window to appear within the update window.

6 In the window that just popped up, use the arrow keys to highlight

From Tape Device to Local System ->

then press the <RETURN> key on the keyboard.

This will cause a new window to appear within the update window.

Continued on next page
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7.8 Upgrade Instructions - Release 200 to Release 200,  Continued

Loading the UxS
Personality for UxS
R200 tape, continued

Step Action

7 In the window that just popped up you will be prompted to change
the parameters in the file /dev/update.src.  The current parameters
are displayed at the right side of the window.  They should appear as
follows:

major number: 54
slot number:   0
bus address:   1
unit number:   0
volume number: 2

If these settings are correct, use the mouse to position the cursor
over the “Done” button at the bottom of the update window and
press the left button on the mouse.  Go on to the next step.

If a change needs to be made, position the cursor over the “n” in the
following question using the arrow keys on the keyboard and type
“y”.

Create or change the address of
/dev/update.src ->

This will cause a new window to appear within the update window.
Make the necessary changes and use the mouse to position the
cursor over the “Done” button at the bottom of the update window
and press the left button on the mouse.  Select the “Done” button a
second time.

8 Once the light on the tape drive has stopped blinking, use the arrow
keys on the keyboard to highlight.

Select All Filesets on the Source Media->

then press the <RETURN> key on the keyboard.

This will cause a new window to appear within the update window.

Continued on next page
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7.8 Upgrade Instructions - Release 200 to Release 200,  Continued

Loading the UxS
Personality for UxS
R200 tape, continued

Step Action

9 In the new window, use the arrow keys on the keyboard to highlight

Start loading now?

then press the <RETURN> key on the keyboard.

Note:  You may get one or more warning messages at this time.  You
may either select “y” to get more information or “n” to proceed with
the installation.

10 After a few seconds a window will pop up and the final sentence in
the window will ask.

Start loading filesets now?

When this window appears, press the “y” key on the keyboard.

This will start the update.

Note:  You may get a “Summary of Warnings” message window.  It will
tell you that a kernel rebuild and system reboot is required and ask if
you would like further information.  An answer of n will continue with
the software loading process.

After all filesets have been loaded, the system will reboot.  This
process should take 2 to 3 minutes.

11 Remove the UxS Personality for UxS R200 tape from the tape unit by
pressing the eject button. The green light will flash while the unit
positions the tape to its beginning. When the tape is ejected from the
unit, remove it and return it to its protective case.

12 Shutdown and re-load the “LCN side” of the Universal StationX.
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7.9 Preparing Software Update Server(Server Only)

Introduction This procedure is used to prepare a Universal StationX system to distribute
software updates from a local DDS tape media to other Universal StationX

stations via Ethernet.

WARNING Warning - This procedure must only be done on a Universal StationX
previously upgraded to Release 200 software.

Required configuration This procedure requires a DAT tape unit connected to the Universal
StationX station. The station must be operational with full user-login
capabilities and connected to an Ethernet network accessible to all Universal
StationXs to be updated.

CAUTION Universal StationX stations being used as full software update servers must
have a 1 gigabyte hard disk drive.  An additional method would be to move
the netdist area to a second 525mb disk drive.  Only software updates
containing a small number of filesets should be loaded for network
distribution on a single 525mb disk drive system.

Restart after reboot If the coprocessor is rebooted/shutdown before all machines are updated,
the network distribution daemon will need to be restarted. This is done by
typing /etc/netdistd at the UNIX shell prompt accessed from the
system configuration menu.

Required access level The procedures must be performed while logged in as “engineer.”  The
coprocessor (root) password is required.

Menu appearance   Engineer Menu

Window Menu      >
X Manager Menu   >
Application Menu >
System Menu      >

  System Commands

Configuration     >
Update Software   >
Add/Remove Users...
Backup/Restore...  

51160

Update Type

Local...
Network...

Continued on next page
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7.9 Preparing S/W Update Server (Server Only),  Continued

Prior network
distribution server

If a previous network distribution process is running, this procedure will
cause a coprocessor reboot. Reinitiate this procedure after the system has
rebooted.

Detailed installation
instructions

To install the update, perform each of the following steps in sequence.
Warning: Do not continue if any step cannot be completed successfully.

Step Action

1 Remove the update tape from its protective case and gently insert it
into the tape drive. Press gently on the edge of the tape cartridge
while inserting it into the unit until you feel the unit pull on the tape.
The unit will then load and position the tape. While positioning is
being performed, both indicator lamps on the front of the unit will
flash. When the right lamp shows a solid green, positioning is
complete and the tape unit is ready to use.

If you are unable to successfully insert the tape, gently remove the
cartridge and reinsert it again. If you are still unsuccessful, contact
your Honeywell service representative for assistance.

2 At the station with the DAT drive, login as engineer.

3 Select Update Software - Network from the workspace menu.

4 Type the coprocessor (root) password and <RETURN> at the prompt.

5 If a software update has been previously performed on the station,
you will see a message telling you that the network daemon is already
running.  The system will reboot automatically and you will begin this
procedure again at Step 2.

6 A prompt will appear asking you “Remove existing network update
files [Y/n]?”.  Enter “y” to this question.

7 In the update window, use the arrow keys on the keyboard to
highlight

Change Source or Destination ->

then press the <RETURN> key on the keyboard.

This will cause a new window to appear within the update window.

8 In the window that just popped up, use the arrow keys to highlight

From Tape Device to Local System->

then press the <RETURN> key on the keyboard.

This will cause a new window to appear within the update window.

Continued on next page
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7.9 Preparing S/W Update Server (Server Only),  Continued

Detailed installation
instructions, continued

Step Action

9 In the window that just popped up you will be prompted to change
the parameters in the file /dev/update.src.  The current parameters
are displayed at the right side of the window.  They should appear as
follows

major number: 54
select code:   0
bus address:   1
unit number:   0
volume number: 2

If these settings are correct, use the mouse to position the cursor
over the “Done” button at the bottom of the update window and
press the left button on the mouse.

If a change needs to be made, position the cursor over the “n” in the
following question using the arrow keys on the keyboard and type
“y”.

Create or change the address of
/dev/update.src ->

This will cause a new window to appear within the update window.
Make the necessary changes and use the mouse to position the
cursor over the “Done” button at the bottom of the update window
and press the left button on the mouse.

10 Using the mouse, position the cursor over the “Done” button at the
bottom of the update window and press the left button on the
mouse.

This will cause the top window to close and the light on the tape drive
will begin blinking for a few seconds.

11 Once the light on the tape drive has stopped blinking, use the arrow
keys on the keyboard to highlight.

Select All Filesets on the Source Media->

then press the <RETURN>key on the keyboard.

This will cause a new window to appear within the update window.

12 You may get a message asking if you want to create a netdist
directory.  If so, enter y.

13 A prompt window may appear asking if you intend on loading to a
series 700 or series 800.

Enter 7.

Continued on next page
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7.9 Preparing S/W Update Server (Server Only),  Continued

Detailed installation
instructions, continued

Step Action

14 In the new window, use the arrow keys on the keyboard to highlight

Start loading now?

then press the <RETURN> key on the keyboard.

15 Remove the tape from the tape unit by pressing the eject button. The
green light will flash while the unit positions the tape to its beginning.
When the tape is ejected from the unit, remove it and return it to its
protective case.

Remote Update Note:  This procedure prepares the Universal StationX with the DAT drive
to be a netdist server.  This allows Universal StationXs without DAT drives
to specify this station as the source for their updates.  This procedure does
not update the software in those stations.  To update the software in those
stations (without DAT drives), perform the “Remote Coprocessor S/W
Update” procedure at each of those stations.

Update Errors If any minor errors or warnings occurred, they will be displayed upon
completion of the update process.  Please record each message and press
the Search target to display the next message. When all messages have
been displayed, the system will beep. Select the Exit target.

If any major errors occurred during the update, this message is
displayed:Update Failed!!!  Call the Technical
Assistance Center for help.  The process will not continue.
You must contact Honeywell’s TAC to resolve the errors.
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7.10 Remote Coprocessor Software Update

Introduction This procedure installs the software update from another Universal StationX

station on the Ethernet network.

Required configuration This procedure requires that an additional Universal StationX station be
connected to the LAN, which contains the update software for Universal
StationX and is running the “netdist” daemon. This master system must be
prepared following subsection 7.9, “Preparing Software Update Server
(Server Only).”

Required access level The procedures must be performed while logged in as “engineer.”  The
coprocessor (root) password is required.

Menu appearance   Engineer Menu

Window Menu      >
X Manager Menu   >
Application Menu >
System Menu      >

  System Commands

Configuration     >
Update Software   >
Add/Remove Users...
Backup/Restore...  

51160

Update Type

Local...
Network...

Detailed installation
instructions

The following will complete the update installation from tape media.
Execute each step in sequence. Warning: Do not continue if any step cannot
be completed successfully.

Step Action

1 Select Update Software - Local from the workspace menu.

2 Type the coprocessor (root) password and <RETURN> at the prompt.

3 In the update window, use the arrow keys to highlight

Change Source or Destination ->

then press the <RETURN> key on the keyboard.

This will cause a new window to appear within the update window.

Continued on next page



4/96 R200 Universal StationX System Administration 111

7.10 Remote Coprocessor S/W Update ,  Continued

Detailed installation
instructions, continued

Step Action

4 In the window that just popped up, use the arrow keys to highlight

From Netdist Server to Local System->

then press the <RETURN> key on the keyboard.

This will cause a new window to appear within the update window.

5 In the window that just popped up, this message is displayed:

Netdist Server (Source):

Enter the name of the node which contains the update files, then
press the <RETURN> key on the keyboard.

6 Using the mouse, position the cursor over the “Done” button at the
bottom of the update window and press the left button on the
mouse.

This will cause the top window to close.

7 In the window that just popped up, use the arrow keys to highlight

Select All Filesets on the Source Media->

then press the <RETURN> key on the keyboard.

This will cause a new window to appear within the update window.

8 In the new window, use the arrow keys on the keyboard to highlight

Start loading now?

then press the <RETURN> key on the keyboard.

9 After a few seconds, a window will pop up and the final sentence in
the window will ask.

Start loading filesets now?

When this window appears, press the “y” key on the keyboard.

This will start the update.

Continued on next page
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7.10 Remote Coprocessor S/W Update,  Continued

Detailed installation
instructions, continued

Step Action

10 The coprocessor may reboot automatically.  This reboot will take
approximately 14 minutes.  During this time “DO NOT” cycle power or
reset the UNIX coprocessor.  Resetting the coprocessor in this 14
minute window will cause corruption of the system disk.  If the system
has not come back up within 30 minutes, then the coprocessor is in a
halted state and you must cycle power to the node.   It will take up to
20 minutes for the UNIX software to come up.

11 Reset the Universal StationX node.

If your Universal StationX node is packaged in a standard
Honeywell TDC 3000X console cabinet, the reset button is
located under the folding top edge of the operator's keyboard.

If your Universal StationX node is packaged in the new ergonomic
design , Honeywell TDC 3000X console cabinet, the reset button
is a recessed button located at the top edge of the operator's
keyboard.  Use a ball point pen or similar device to activate this
button.

If your Universal StationX node is packaged in a Honeywell Micro-
TDC tower cabinet, the reset button can be accessed only by
removing the front cabinet cover and pressing the button located
on the front edge of the module power supply.

Your Universal StationX node software will automatically reload
from the local disk storage media. This reload process should
take approximately 5 minutes. After that time, you will observe the
login bar appear at the bottom portion of the display screen
indicating the Universal StationX station is now ready to use.

Update errors If any minor errors or warnings occurred, they will be displayed upon
completion of the update process.  Please record each message and press
the Search target to display the next message. When all messages have
been displayed, the system will beep. Select the Exit target.

If any major errors occurred during the update, this message is
displayed:Update Failed!!!  Call the Technical
Assistance Center for help.  The process will not continue.
You must contact Honeywell’s TAC to resolve the errors.
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7.11 Checking Tracking Files

Software tracking There are several utilities within UNIX which provide troubleshooting
information by constantly providing on-line recording of certain
events/messages. This information can often help in locating the trouble
source.

Interpreting the file contents is beyond the scope of this publication;
however, the location and use of these files will be described here.

Login logs The system logs all login attempts in the /etc directory. You may check the
logs to determine if there have been any attempts to gain unauthorized
access.

Login attempt Recorded in log file

Successful Login /etc/wtmp

Failed Login /etc/btmp

The files are stored in binary format.  Use the UNIX command last to
read the wtmp file (successful logins and logouts) and the command lastb
to read the btmp file (failed logins). For example,
last /etc/wtmp <RETURN>
lastb /etc/btmp <RETURN>

Shutdown log The system logs all shutdowns in the file /usr/adm/shutdownlog. Check
this file for any unattended shutdowns (power outage) or any abnormal
conditions incurred during past shutdowns.
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7.12 Software Restoration From Local DAT

Overview This procedure will restore the software from DAT tapes to the UXS’s hard
drive.  It can be used when the software on the hard disk has been
corrupted, or when the hard disk has been replaced with one that has no
software.  This procedure requires the UXS to have a DAT drive.  If it does
not, use the “Software Restoration from a Server” procedure.

This procedure should take about 1.5 to 2.5 hours.

Required In order to complete this procedure, you must have:
vt100 terminal (or a terminal that emulates vt100)
cable that connects the vt100 to the WSI2 I/O board
DAT tapes:

HP-UX Install (UxS R200)
UxS Windows SW (RELEASE 200)
UxS Personality for UxS R200
HP-UX 9.05 Patches (UxS R200,...)
Optional HP-UX 9.05 Patches (UxS R200,...)

hostname and IP address of the destination UXS
hostname and IP address of the server UXS
coprocessor (root) password of the server UXS

Preferred (in addition to
Required)

DAT tapes:
system backup

Optional (in addition to
Required)

In order to complete this procedure, you might want to have:
subnet mask for your LAN
hostname and IP address of the gateway
hostname and IP address of the BIND server

Restore procedure

Step Action

1 Connect a vt100 terminal to the WSI2 I/O board.  Henceforth, this
terminal will be called the system console.

2 After powering on the processor chassis, use the  ESC key on your
system console to halt the boot process.

Note:  Press the ESC key after after receiving the prompt to halt the
boot process.

3 Insert the HP-UX Install (UxS R200) tape into the DAT tape drive.

4 Wait for the tape to load.  When the lights on the drive stop blinking,
enter 1 (Boot From a Device) and press <RETURN> .

Continued on next page
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7.12 Software Restoration From Local DAT,  Continued

Restore procedure,
continued

Step Action

5 Look for the line:

SCSI.1.0 HP

To the left of that line (under Key) will be a number (probably a 2).
Enter that number and press <RETURN>.  This will take 2 to 3 minutes.

6 You will get a message that the EISA configuration has completed.

Press any key to continue.

7 Installation step information will be presented.  Press any key to
continue.

8 You will now be at the HP-UX INSTALLATION UTILITY.  Look for the
line with your type of disk listed.  It will probably be one of the
following:

HP C2235  or
Quantum LPS525S  or
Seagate ST3600N  or
Digital DSP 3107L  or
Quantum LPS1080S  or
Quantum VP31110  or
Seagate ST31200  or
Quantum VP32210  or
Seagate ST32430N  or
HP C3325A

Note:  It will have Slot Number = 0, Bus Addr = 6, and Func Num = 1.

To the left of that line will be a number (probably a 1).  Enter that
number.

9 You may get a warning message about an HP-UX system already
being on this disk.  Press any key to continue.

10 Do you want the root file system to allow long filenames?

Enter y.

11 Enter 1 to Continue Installation Process.

12 Enter  80000 (or leave as default—whichever is larger) for the Root
Disk Swap Space and press <RETURN>.

Note:  If you chose to use the default Root Disk Swap Space, skip the
next two steps.

13 You may get a message indicating that swap space will be rounded to
match system constraints.  If so, press <RETURN>.

Continued on next page
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7.12 Software Restoration From Local DAT,  Continued

Restore procedure,
continued

Step Action

14 The Root Disk Swap Space will show a new number.  Press
<RETURN>

15 You will get a warning message that continuing the installation
process will destroy the contents of your disk.  Enter y to continue.

You will see a message (making file system).  The tape will begin
loading files.  When complete, the system will reboot.  This will take 2-
3 minutes.

16 After the system reboots, you will get a  message “A PS/2 DIN
interface has been detected ...” message will be displayed.

Press <Enter> to continue.

Note:  You may get a “failed” message after pressing enter.  This will
be corrected later in the upgrade.

17 Remove the HP-UX Install (UxS R200) tape from the DAT tape drive.

18 Insert the UxS Windows SW (RELEASE 200) tape.  Wait for the lights
to stop blinking.

19 You will get a message asking you to confirm that the update media
has replaced the install media.  Press <RETURN>.

20 Select Select All Filesets on Source Media and press
<RETURN>.

21 Select Start Loading Now and press <RETURN>.

You will get a message: Calculating Disk Space
Requirements.

22 Enter y to Start Loading Filesets Now?

Note:  This will take about 20 to 30 minutes.When the load is
complete, the system will reboot automatically.  The reboot process
will ask for a number of items:

Your intended Hostname
Your Internet Protocol (IP) address for the station
Subnetwork mask
Gateway Information
BIND server information
Timezone information
Password for the coprocessor (root)

Follow the prompts through the configuration options.

23 When the system comes back up, login as root at the system
console.

Continued on next page
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7.12 Software Restoration From Local DAT,  Continued

Restore procedure,
continued

Step Action

24 If you do NOT have a DAT tape with a system backup on it, continue
with the next step.  If you do, perform the following:

1.  Insert the system backup tape in the DAT drive.
2.  Enter /etc/frecover -rov and press <RETURN>.

Note: this will take about 30-45 minutes.
3.  Enter reboot -q and press <RETURN>.

This completes the procedure—your station has been restored to
the state it was in at the time of your last system backup.

25 At the prompt, enter more /etc/kbdlang and press <RETURN>.

If you get :
/etc/kbdlang: No such file or directory
Enter
echo “PS2_DIN_US_English” > /etc/kbdlang and press
<RETURN>

26 Remove the UxS Windows SW (RELEASE 200) tape from the DAT
tape drive.

27 Insert the UxS Personality for UxS R200 tape into the DAT tape drive.
Wait for the lights to stop blinking.

28 Enter /etc/update and press <RETURN>

29 Select Select All Filesets on the Source Media and
press <RETURN>

30 Select Start Loading Now and press <RETURN>

31 Enter y to Start Loading Filesets Now? (y or n)

Note:  Tape load will take about 1 to 3 minutes.

32 When the update is done, remove the UxS Personality for UxS R200
tape from the DAT tape drive.

33 Insert the HP-UX 9.05 PATCHES(UxS R200, AxM R110, AxM R200)
tape into the DAT drive.  Wait for the lights to stop blinking.

34 Enter /etc/update and press <RETURN>

35 Select Select All Filesets on the Source Media and
press <RETURN>

36 Select Start Loading Now and press <RETURN>

37 You will get a warning message about a kernel rebuild.

Enter n to continue.

Continued on next page
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7.12 Software Restoration From Local DAT,  Continued

Restore procedure,
continued

Step Action

38 Enter y to Start Loading Filesets Now? y or n

The system will reboot automatically after the filesets are loaded.

Note:  This will take about 20-25 minutes.

39 After the system has come back up, remove the HP-UX  Patches
(UxS R200, AxM R110, AxM R200) tape from the DAT tape drive.

40 Insert the Optional HP-UX 9.05 PATCHES(UxS R200, AxM R110,
AxM R200) tape into the DAT drive.  Wait for the lights to stop
blinking.

41 Login as root at the system console.

42 Enter /etc/update and press <RETURN>

43 If you wish to load all optional patches:
1.  Select Select All Filesets on the Source Media and
press <RETURN>
2.  Select Start Loading Now and press <RETURN>

If you wish to load only some of the optional patches (because of
limited disk space):
1.  Select Select/View Partitions and Filesets and press
<RETURN>
2.  Enter a Y to the left of the patches you want to load
3.  Press the <control> and f keys together, release them and
then press the numeric 4 key.

44 You may get a warning message about a kernel rebuild (depending
on your selections in the previous step).

If you get the warning, enter n to continue (no more information).

45 Enter y to Start Loading Filesets Now? y or n

If you got the “kernel rebuild” warning, the system will reboot
automatically after the filesets are loaded.

Note:  This will take about 5-10 minutes.

46 If the system did not automatically reboot, type reboot -q and
press <RETURN>

47 After the system has come back up, remove the Optional HP-UX 9.05
PATCHES(UxS R200, AxM R110, AxM R200) tape.

Continued on next page
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7.12 Software Restoration From Local DAT,  Continued

Restore Completed At this point, all the software is loaded on the UXSs hard drive.  The UXS
also has minimal configuration.  Because you do not have a system backup
on DAT, you must “manually” configure your system to recover your data
base.

Manual Data Base
Recovery Procedure

Step Action

1 “Manually” configure your system.

Note:  You are here because you do not have a DAT tape containing
a system backup; therefore, you must configure your system from
scratch.  Follow the appropriate sections in the UXS System
Administration Manual to complete the configuration.

Examples of procedures you must follow:

Configure Coprocessor LAN Information
Configure LAN Routing
Configure Security for Remote Users
Configure Coprocessor Printer
Create New Coprocessor Users
Industrial Workspace Manager
CRT Configuration (for dual CRT UXSs)

2 If you have a DAT tape containing a user backup, restore it by using
the Restore Local Coprocessor Hard Drive Data procedure in the UXS
System Administration Manual.  If not, “manually” configure user files.
This can be done by using ftp to copy user files from other UXSs (if
available) , or by following the procedures in the Coprocessor User
Environment Configuration section of the UXS System
Administration Manual.

3 Install any optional software by following the instructions that came
with that software.

4 Perform a complete backup of your system by following the Backup
the Local Coprocessor Hard Drive procedure in the UXS System
Administration Manual.
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7.13 Software Restoration from a Server

Overview This procedure loads software (and database if available) from DAT tapes to
a hard drive.  It is intended to be used when the UXS with the corrupted file
system does not have a DAT drive.  Another UXS (which does have a DAT
drive) will be required to perform this procedure.  The UXS with the DAT
drive will be referred to as the server UXS.  The UXS with the corrupted
file system will be referred to as the destination UXS.

During the restore procedure you will be asked to move between the server
UXS and the destination UXS.  The procedure should take about 2.5 to 3.5
hours.

CAUTION This procedure requires the server UXS to have a 1 gigabyte (or larger)
hard disk drive.  Although it is possible to restore from a server UXS with
a 525mb hard drive (small portions each time), this procedure will not
discuss that method.  Another method (also not discussed here) is to move
the netdist area to a second 525mb disk drive.  Only software updates
containing a small number of filesets should be loaded for network
distribution on a single 525mb disk drive system.

Required In order to complete this procedure, you must have:
vt100 terminal (or a terminal that emulates vt100)
cable that connects the vt100 to the WSI2 I/O board
UXS (server) with a 1.2G (or larger) hard drive and a DAT drive
DAT tapes:

UxS Windows SW (RELEASE 200)
UxS Personality for UxS R200
HP-UX 9.05 Patches (UxS R200,...)
Optional HP-UX 9.05 Patches (UxS R200,...)

hostname and IP address of the destination UXS
hostname and IP address of the server UXS
coprocessor (root) password of the server UXS

Preferred (in addition to
Required)

In order to complete this procedure, is is preferable if you have:
DAT tapes:

system backup

Optional (in addition to
Required)

In order to complete this procedure, you might want to have:
subnet mask for your LAN
hostname and IP address of the gateway
hostname and IP address of the BIND server

Continued on next page
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7.13 Software Restoration from a Server,  Continued

Destination UXS -
procedure 1

Step Action

1 Connect a vt100 terminal to the WSI2 I/O board of the destination
UXS.  Henceforth, this terminal will be referred to as the system
console.

2 After powering on the destination UXS processor chassis, use the
ESC key on your system console to halt the boot process.

Note:  Press the ESC key after after receiving the prompt to halt the
boot process.

3 Enter 6 and press <RETURN>.  (Hardware Information)

4 Enter 1 and press <RETURN>.  (I/O ASIC)

5 Look for the following information:

LAN      080009 - xxxxxx

Write down the last six digits. (Example - 0AFC5D)

6 Enter 0 and press <RETURN>  (Previous Menu)

7 Enter 0 and press <RETURN>  (Previous Menu)

Server  UXS -
procedure 1

1 Now the station to be used as the sever must be set up.

At the server UXS, insert the UxS Windows SW (RELEASE 200) tape
into the DAT tape drive.

2 Login as engineer.

3 Select System Menu->Update Software->Network from the
menu.

4 Enter the coprocessor (root) password and press <RETURN>.

Note:  If this UXS has been used as a netdist server before, you may
get a message that the network daemon is already running, and the
system will reboot.  If it does, perform the following steps:

Login as engineer.
Select System Menu->Update Software->Network
Enter the coprocessor (root) password and press <RETURN>.
Enter y and press <RETURN>to remove existing files.

Note:  This may take 5-10 minutes.

Continued on next page
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7.13 Software Restoration from a Server,  Continued

Sever UXS -
procedure 1, continued

Step Action

5 Select Select All Filesets on Source Media and press
<RETURN>.

You may get a message asking if you want to create a netdist
directory.  If so, enter y.

6 A prompt window may appear asking if you intend on loading to a
series 700 or series 800.

Enter 7

7 Select Start Loading Now and press <RETURN>.

8 Enter y to Start Loading Filesets Now? (y or n).

Note:  Continue with the next step.

When the tape load is complete, the Create_Network_Master
window will close.  This will take about 20-25 minutes.

9 While the previous step is executing we will proceed with another part
of the setup process.

At the server UXS, select
System Menu->Configuration->System Configuration
from the menu.

10 Enter the coprocessor (root) password and press <RETURN>.

11 Select Networking/Communications and press <RETURN>.

12 Select Device Connectivity and press <RETURN>.

13 Select Boot Protocol and press <RETURN>.

14 From the window title bar select Actions.

15 Select Add.

16 Into the form presented, enter the bootp device name (This is the
internet node name of the destination UXS).

17 You may get a note window with a message about connectivity not
being configured.  If you do, select ok.

18 The internet protocol address may be filled in automatically.  If not, fill
it in.

19 Enter the Subnet Mask  (example- 255.255.255.0)

Continued on next page
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7.13 Software Restoration from a Server,  Continued

Sever UXS -
procedure 1, continued

Step Action

20 Enter the Station Address 080009xxxxxx.

Where xxxxxx is the number copied from the destination UXS.  This
number was obtained earlier in this procedure.

21 Enter the bootfile name /usr/lib/uxinstlf.700

Note:  You may get an error: Unable to stat file
/usr/tftpdir//usr/lib/uxinstlf.700.  No such file or directory.  If you do,
perform the following:
1.  Select System Menu->Configuration->System Terminal
2.  Enter the coprocessor (root) password and press <RETURN>.
3.  Enter cp /usr/lib/uxinstlf.700 /usr/tftpdir/ and
press <RETURN>.
4.  Select No in the Confirmation window.
5.  Enter the bootfile name uxinstlf.700

22 Select ok.

You will be returned to the Device Connectivity window.

23 Select File and then Exit from the window title bar to close the
window.

Note:  You may get a message about enabling the Bootp server.  If
so, select  yes.

24 Select Exit SAM.

25 Wait for the tape load begun earlier to complete.

Note:  When complete, the Create_Network_Master window will
close.

26 Remove the UxS Windows SW (RELEASE 200) tape from the DAT
tape drive and go to the destination UXS.

Destination  UXS -
procedure 2

Step Action

1 On the system console connected to the destination UXS, enter 1
(Boot From Device), and press <RETURN>.

2 Look for the IP address of the server UXS.  To the left (under Key) will
be a number (probably a 1).  Enter that number and press <RETURN>.

Continued on next page
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7.13 Software Restoration from a Server,  Continued

Destination  UXS -
procedure 2, continued

Step Action

3 You will get a message that the EISA configuration has completed.

Press any key to continue.

4 Installation step information will be presented.

Press any key to continue.

5 A list of required information (for a network install) will be presented.

Press any key to continue.

6 Enter the IP address of this host and press <RETURN>.

7 Enter the IP address of the server UXS and press <RETURN>.

8 Enter port number 2106 and press <RETURN>.

9 Enter a Gateway address or the word “none” and press <RETURN>.

10 Enter a Subnet mask or the word “none” and press <RETURN>.

11 Press <control> X

12 You will now be at the HP-UX INSTALLATION UTILITY.  Look for the
line with your type of disk listed.  It will probably be one of the
following:

HP C2235  or
Quantum LPS525S  or
Seagate ST3600N  or
Digital DSP 3107L  or
Quantum LPS1080S  or
Quantum VP31110  or
Seagate ST31200  or
Quantum VP32210  or
Seagate ST32430N  or
HP C3325A

Note:  It will have Slot Number = 0, Bus Addr = 6, and Func Num = 1.

To the left of that line will be a number (probably a 1).  Enter that
number.

13 You may get a warning message about an HP-UX system already
being on this disk.  Press any key to continue.

14 Do you want the root file system to allow long filenames?

Enter y.

15 Enter 1 to Continue Installation Process.

Continued on next page
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7.13 Software Restoration from a Server,  Continued

Destination  UXS -
procedure 2, continued

Step Action

16 Enter  80000 (or leave as default—whichever is larger) for the Root
Disk Swap Space and press <RETURN>.

Note:  If you chose to use the default Root Disk Swap Space, skip the
next two steps.

17 You will get a message indicating that swap space will be rounded to
match system constraints.  Press <RETURN>.

18 The Root Disk Swap Space will show a new number.  Press
<RETURN>

19 You will get a warning message that continuing the installation
process will destroy the contents of your disk.  Enter y to continue.

You will see a message (making file system).  The system will begin
loading files from the server UXS.  When complete, the system will
reboot.

20 After the system reboots, you will get a  message “A PS/2 DIN
interface has been detected ...” message will be displayed.

Press <Enter> to continue.

21 You will be taken to the update program.

Select Select All Filesets on Source Media and press
<RETURN>.

22 Select Start Loading Now and press <RETURN>.

You will get a message: Calculating Disk Space
Requirements.

23 Enter y to Start Loading Filesets Now? (y or n).

Note:  Wait for the load to complete.  This will take about 30-45
minutes.

The system will reboot automatically.  The reboot process will ask for a
number of items:

Your intended Hostname
Your Internet Protocol (IP) address for the station
Subnetwork mask
Gateway Information
BIND server information
Timezone information
Password for the coprocessor (root)

Follow the prompts through the configuration options.

24 Wait until the system finishes coming up.

Continued on next page
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7.13 Software Restoration from a Server,  Continued

Restore system backup

Step Action

1 If you do NOT have a DAT tape with a system backup on it, continue
with the next procedure (Server UXS—procedure 2).  If you do, then
login as root at the system console.

2 Insert the backup tape in the server UXS’s DAT drive.

3 At the system console connected to the destination station, type vi
/etc/hosts and press <RETURN>.

4 Enter <Shift>ga (GA) and press <RETURN>.

5 Enter the IP address and host name of the server UXS.
Ex:  164.145.114.52 trn2
Note:  Limit the host name to 8 characters.

6 Press <Esc>

7 Enter :wq! and press <RETURN>.

8 Verify that the name of the destination station node is in the /.rhosts
file of the server UXS’.  If it is, go to the next step, if not, follow these
instructions to add it:
a. At the server UXS, select:

System Menu->Configuration->System Terminal 
from the workspace menu.

b. Enter the coprocessor (root) password and press 
<RETURN>.

c. Enter vi /.rhosts and press <RETURN>.
d. Enter <Shift>ga (GA) and press <RETURN>.
e. Enter the full name of the destination node (alias names

cannot be used).
f. Press <ESC>.
g. Enter :wq! and press <RETURN>.
h. Enter exit and press <RETURN> to close the system 

terminal window on the server UXS.

9 Type /etc/frecover -rov -f svrhstnm:/dev/rmt/0m and
press <RETURN>.  (where svrhstnm  is the host name of the server
UXS).
Ex: frecover -rov -f trn2:/dev/rmt/0m

Note1:  0m is   zero  m, not   oh  m
Note2:  This will take about 60-75 minutes.

10 After the frecover has completed, type reboot -q and press
<RETURN>.

This completes the procedure—your station has been restored to
the state it was in at the time of your last system backup.

Continued on next page
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7.13 Software Restoration from a Server,  Continued

Server  UXS -
procedure 2

Step Action

1 At the server UXS, insert the UxS Personality for UxS R200 tape.

2 Select  System Menu->Update Software->Network  from the
menu.

3 Enter the coprocessor (root) password and press <RETURN>.

Note: Because a network daemon is already running, the system
will automatically reboot.

4 Login as engineer.

5 Select System Menu->Update Software->Network from the
menu.

6 Enter the coprocessor (root) password and press <RETURN>.

7 You will get a message asking if you want to remove existing update
files [Y/n].  Enter y and press <RETURN>.

Note:  This will take about 5-7 minutes.

8 Select Select All Filesets on the Source Media and
press <RETURN>.

9 Select Start Loading Now and press <RETURN>.

10 Enter y to Start Loading Filesets Now? (y or n).

Note:  Wait for the load to complete.  When complete, the
Create_Network_Master  window will close.  This will take about 1-2
minutes.

11 Remove the UxS Personality for UxS R200 tape and go to the
destination UXS.

Continued on next page
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7.13 Software Restoration from a Server,  Continued

Destination UXS -
procedure 3

Step Action

1 On the system console connected to the destination UXS, login as
root.

2 At the prompt, enter more /etc/kbdlang and press <RETURN>

If you get:
/etc/kbdlang: No such file of directory

Enter:  echo “PS2_DIN_US_English” > /etc/kbdlang
and press <RETURN>

3 Enter /etc/update and press <RETURN>.

4 Select Change Source or Destination and press <RETURN>.

5 Select From Netdist Server to Local System and press
<RETURN>

6 Enter the IP address of the server.

Press the <control> and f keys together, release them and then
press the numeric 4 key.

7 Select Select all Filesets on the Source Media and
press <RETURN>.

8 Select Start Loading Now and press <RETURN>.

9 Enter y to Start Loading Filesets Now? (y or n).

Note:  Wait for the load to complete.  When complete, you will be
returned to a shell prompt (#).  This will take about 1 minute.

Server  UXS -
procedure 3

Step Action

1 At the server UXS, insert the HP-UX 9.05 PATCHES (UxS R200, AxM
R110, AxM R200) tape.

2 Select System Menu->Update Software->Network  from the
menu.

3 Enter the coprocessor (root) password and press <RETURN>.

Note: Because a network daemon is already running, the system
will automatically reboot.

Continued on next page
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7.13 Software Restoration from a Server,  Continued

Server  UXS -
procedure 3, continued

Step Action

4 Login as engineer.

5 Select System Menu->Update Software->Network from the
menu.

6 Enter the coprocessor (root) password and press <RETURN>.

7 You will get a message asking if you want to remove existing update
files [Y/n].  Enter y and press <RETURN>.

Note:  This will take about 1 minute.

8 Select Select All Filesets on the Source Media and
press <RETURN>.

9 A prompt window may appear asking if you intend on loading to a
series 700 or series 800.

Enter 7

10 Select Start Loading Now and press <RETURN>.

11 Enter y to Start Loading Filesets Now? (y or n).

Note:  Wait for the load to complete.  When complete, the
Create_Network_Master  window will close.  This will take about 3-5
minutes.

12 Remove the HP-UX 9.05 PATCHES (UxS R200, AxM R110, AxM
R200) tape and go to the destination UXS.

Destination UXS -
procedure 4

Step Action

1 On the system console connected to the destination UXS, enter
/etc/update and press <RETURN>.

2 Select Change Source or Destination and press <RETURN>.

3 Select From Netdist Server to Local System and press
<RETURN>.

4 Enter the IP Address of the Server.

Press the <control> and f keys together, release them and then
press the numeric 4 key.

Continued on next page
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7.13 Software Restoration from a Server,  Continued

Server  UXS -
procedure 3, continued

Step Action

5 Select Select all Filesets on the Source Media and
press <RETURN>.

6 Select Start Loading Now and press <RETURN>.

Note: You may get a warning message informing you that a kernel
rebuild and reboot is required.  Enter n to this message.

7 Enter y to Start Loading Filesets Now? (y or n).

Note:  Wait for the load to complete.  This will take about 20-25
minutes.

Note:  After loading is complete the station will reboot.

Server  UXS -
procedure 4

Step Action

1 At the server UXS, insert the Optional HP-UX 9.05 PATCHES (UxS
R200, AxM R110, AxM R200) tape.

2 Select System Menu->Update Software->Network  from the
menu.

3 Enter the coprocessor (root) password and press <RETURN>.

Note: Because a network daemon is already running, the system
will automatically reboot.

4 Login as engineer.

5 Select System Menu->Update Software->Network from the
menu.

6 Enter the coprocessor (root) password and press <RETURN>.

Continued on next page
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7.13 Software Restoration from a Server,  Continued

Server  UXS -
procedure 4, continued

Step Action

7 You will get a message asking if you want to remove existing update
files [Y/n].  Enter y and press <RETURN>.

Note:  This will take about 1 minute.

8 If you wish to load all optional patches:
1.  Select Select All Filesets on the Source Media and
press <RETURN>
2.  Enter 7.
3.  Select Start Loading Now and press <RETURN>

If you wish to load only some of the optional patches (because of
limited disk space):
1.  Select Select/View Partitions and Filesets and press
<RETURN>
2.  Enter 7.
3.  Enter a Y to the left of the patches you want to load
4.  Select the Start Loading target.

9 Enter y to Start Loading Filesets Now? (y or n).

Note:  Wait for the load to complete.  When complete, the
Create_Network_Master  window will close.  This will take about 3-5
minutes.

10 Remove the Optional   HP-UX 9.05 PATCHES (UxS R200, AxM
R110, AxM R200) tape and go to the destination UXS.

Destination UXS -
procedure 5

Step Action

1 On the system console connected to the destination UXS, login as
root.

2 Enter /etc/update and press <RETURN>.

3 Select Change Source or Destination and press <RETURN>.

4 Select From Netdist Server to Local System and press
<RETURN>.

5 Enter the IP address of the server.

Press the <control> and f keys together, release them and then
press the numeric 4 key.

Continued on next page
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7.13 Software Restoration from a Server,  Continued

Destination UXS -
procedure 5, continued

Step Action

6 Select Select all Filesets on the Source Media and
press <RETURN>.

7 Select Start Loading Now and press <RETURN>.

8 Depending on which of the optional patches you selected, you may
get a warning message informing you that a kernel rebuild and reboot
is required.  If you get the message, enter n to this message.

9 Enter y to Start Loading Filesets Now? (y or n).

Note:  Wait for the load to complete.  This will take about 5-10
minutes.

If you got the “kernel rebuild” warning, the system will reboot
automatically after the filesets are loaded.

10 If the system did not automatically reboot,you will be returned to a
shell prompt (#).  Type reboot -q and press <RETURN>

Restore Completed At this point, all the software is loaded on the destination UXSs hard drive.
The destination UXS also has minimal configuration.  Because you do not
have a system backup on DAT, you must “manually” configure your
system in order to recover your data base.

Continued on next page
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7.13 Software Restoration from a Server,  Continued

Manual Data Base
Recovery Procedure

Step Action

1 “Manually” configure your system.

Note:  You are here because you do not have a DAT tape containing
a system backup; therefore, you must configure your system from
scratch.  Follow the appropriate sections in the UXS System
Administration Manual to complete the configuration.

Examples of procedures you must follow:

Configure Coprocessor LAN Information
Configure LAN Routing
Configure Security for Remote Users
Configure Coprocessor Printer
Create New Coprocessor Users
Industrial Workspace Manager
CRT Configuration (for dual CRT UXSs)

2 If you have a DAT tape containing a user backup, restore it using the
Restore Local Coprocessor Hard Drive Data procedure in the UXS
System Administration Manual.  If not, “manually” configure user files.
This can be done by using ftp to copy user files from other UXSs (if
available) , or by following the procedures in the Coprocessor User
Environment Configuration section of the UXS System
Administration Manual.

3 Install any optional software by following the instructions that came
with that software.

4 Perform a complete backup of your system by following the Backup
the Local Coprocessor Hard Drive procedure in the UXS System
Administration Manual.
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7.14 System Console Connection

Requirements for
coprocessor console

Some system administration procedures will require a system console to
complete.  Examples of procedures requiring a system console are:
restoring the software on a disk whose file system is corrupt, putting the
UXS in single user mode and performing a backup of the hard drive using
the fbackup command, and troubleshooting more serious problems.

Recommended
Terminal

Honeywell recommends the Digital Equipment Corporation (DEC) VT-100
terminal (or any simple terminal with equivalent functionality) for use as a
system console connected to the coprocessor.

You may also use a PC running suitable terminal emulation software (such
as Windows 3.1 Terminal) to provide DEC VT-100 compatible terminal
functionality.

A UXS, or System Administration and Development workstation (HP
712/60), can also be used as a coprocessor console. The serial port of these
devices must be connected to the serial port of your UXS using the terminal
cable to support this functionality.

Required terminal
options

The terminal must be set to provide the following functionality to
successfully communicate with the coprocessor serial port 1:

• Asynchronous operation

• 9600 bits per second

• 8 bits/character

• No parity

Continued on next page
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7.14 System Console Connection,  Continued

Overview A direct connect interface cable must be connected between the system
console device and the WSI2 I/O board (Serial Port 1).

Figure 7-1 illustrates that several different devices can be used to provide
this system console connection.  It also illustrates how the system console
is connected to the coprocessor.

Figure 7-1 Coprocessor Console Connection
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7.14 System Console Connection,  Continued

Coprocessor system
console interface cable
schematic

Examples of the direct connect terminal interface cable wiring details are
shown in the following diagrams.

Notice that two cable types are described. One is a 9 to 25 pin direct connect
cable and the other is a 9 to 9 pin direct connect cable.

The 9 to 25 pin cable (Figure 7-2 ) is available from Honeywell logistics
using the part number 51196218-300. This is an optional cable. It is not
generally supplied with the UXS.

The 9 to 9 pin cable (Figure 7-3) is available from Honeywell logistics
using the part number 51305069-100.  This is also an optional cable. It is
not generally supplied with the UXS.

Figure 7-2 Coprocessor System Console Cable (9 to 25 pin)
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7.14 System Console Connection,  Continued

Coprocessor system
console interface cable
schematic, continued

Figure 7-3 Coprocessor System Console Cable (9 to 9 pin)
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Note: The dashed lines shown in the 9 to 9 cable diagram above are
required connections. The dashed notation for some of the connections is
used to make the specific wiring easier to read on screen.

Coprocessor system
console connection
procedure

The following table defines the different cable types available for connecting
coprocessor consoles.  Note that these cables are not generally supplied
with the UXS.  They are available by separate order.

Terminal  Device Terminal Connector Cable Part Number

HP 712/60 Workstation RS-232 51305069-100

9 pin(F) to 9 pin(F)

UXS WSI I/O board (J1) 51305069-100

9 pin(F) to 9 pin(F)

VT-100 compatible devices with
9 pin RS-232 connector

Serial port 51305069-100

9 pin(F) to 9 pin(F)

VT-100 compatible devices with
25 pin RS-232 connector

Serial port 51196218-300

9 pin(F) to 25 pin(M)

Continued on next page
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7.14 System Console Connection,  Continued

Procedure Overview As mentioned earlier, you may use any of the following devices for a
system console:
•  DEC VT-100 terminal (or any “dumb” terminal with equivalent
functionality)
•  PC running suitable terminal emulation software (such as Windows 3.1
Terminal) to provide DEC VT-100 compatible terminal functionality
•  R200 UXS
•  HP 712/60 workstation.

There are four procedures that follow this overview—one for each type of
device.  Make sure you use the correct procedure for the device you are
using as a system console.

Dumb terminal
procedure

Use the following procedure if you are using a “dumb terminal”
as the system console.

Setting up VT-100 Emulation on a Dumb Terminal

Note: The coprocessor software defaults to the proper configuration of Serial
Port 1 and no coprocessor configuration actions are required.

Step Action

1 Connect the cable to the 25 pin RS-232 port on the terminal.

2 Connect the cable to the WSI2 I/O board connector for Serial Port 1
(connector J1).

3 Make sure the terminal is powered on.

4 Refer to the terminal documentation and set up the terminal for VT-
100 emulation.

5 Set up the following communication parameters:
9600 baud, 8 data bits, 1 stop bit, no parity

6 If the UXS is not powered on, turn power on now (you can watch the
bootup process)
Note:  Be sure that the toggle switch on the left side of the WSI2
board is in the right (RUN) position.

7 At your system console, press <RETURN>.  You should receive the
login prompt from the UXS

8 Log in as root.

9 Enter setenv TERM vt100 and press <RETURN>.

10 Perform the desired procedure (restore software, backup, etc.).  After
the procedure is complete, return to the next step in this procedure.

11 Enter exit and press <RETURN>.

Continued on next page
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7.14 System Console Connection,  Continued

PC procedure Use the following procedure if you are using a PC with Windows 3.1 for
the system console.

Starting VT-100 Emulation on a PC

Note: The coprocessor software defaults to the proper configuration of Serial
Port 1 and no coprocessor configuration actions are required.

Step Action

1 Connect the cable to the RS-232 port on the back of the PC.  Use the
end marked “HOST RS-232 PORT”.

Note:  Henceforth, the term system console means the PC.

2 Connect the cable to the WSI2 I/O board connector for Serial Port 1
(connector J1).  Use the end marked “WSI2 I/O J1”.

3 Start Windows 3.1 and (if necessary) login to the PC.

4 At the Program Manager, double-click on the Accessories icon.

5 Double-click on the Terminal icon

Note:  If you get the Terminal Error “The selected COM port is either
not supported or is being used by another device.  Select another
port.”, Click OK.
When the Communications window is displayed, Click Cancel.

6 Pull down the Settings menu and select Terminal Emulation
• Select DEC VT-100 (ANSI)
Click OK

7 Pull down the Settings menu and select Terminal Preferences
• Under CR->CR/LF, ensure neither box is selected
• Under Columns, ensure 80 is selected
• At the bottom, ensure Show Scroll Bars is not selected and  

ensure Use Function, Arrow, and Ctrl Keys for Windows
is not selected (very important)

Click OK

8 Pull down the Settings menu and select Communications
• Select COM1
• Select 9600
• Select 8 data bits
• Select 1 stop bit
• Select Parity None
• Select Flow Control None
• Parity Check and Carrier Detect should not be selected
Click OK

9 Maximize the window.

Continued on next page
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7.14 System Console Connection,  Continued

PC procedure,
continued

Step Action

10 If you wish to save your configuration settings, pull down the File
menu, select Save As, enter a filename, and click OK.  The next time
you enter the terminal emulation program, pull down the File menu
and select Open.  This will automatically restore your settings.

11 If the UXS is not powered on, turn power on now (you can watch the
bootup process).

Note:  Be sure that the toggle switch on the left side of the WSI2
board is in the right (RUN) position.

12 At your system console, press <RETURN>.  You should receive the
login prompt from the UXS.

13 Log in as root.

14 Enter setenv TERM vt100 and press <RETURN>.

15 Perform the desired procedure (restore software, backup, etc.).  After
the procedure is complete, return to the next step in this procedure.

16 Enter exit and press <RETURN>.

17 Close the system terminal window.

UXS procedure (R200) Use the following procedure if you are using an R200 UXS to serve as the
system console.  The console serial port (J1) is used on both the “terminal”
UXS, and the UXS to which a terminal is being connected.

Starting VT-100 Emulation on an R200 UXS

Step Action

1 Connect the cable to the WSI2 I/O board connector for Serial Port 1
(connector J1) on the “terminal” UXS.  Use the end marked “HOST
RS-232 PORT”.

Note:  Henceforth, the term system console means the “terminal”
UXS.

2 Connect the cable to the WSI2 I/O board connector for Serial Port 1
(connector J1).  Use the end marked “WSI2 I/O J1”.

3 At the “terminal” UXS, login as engineer.

4 Select Application Menu->Telnet from the workspace menu.

5 Enter ! and press <RETURN>.

Continued on next page
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7.14 System Console Connection,  Continued

UXS procedure (R200),
continued

Step Action

6 Set up the backspace key.

Enter stty erase <SPACE> <BACKSPACE> and press
<RETURN>.

7 Become the root user.

Enter su -root and press <RETURN>.

8 Enter the coprocessor (root) password and press <RETURN>.

9 Find the Process Identification Number (PID) of the console process.

Enter ps -ef | grep console and press <RETURN>.

10 You should see a line of the form:
  root  nnn....../etc/getty  -h  console  console

nnn is the PID—record it here _________

11 Enter kill -STOP nnn and press <RETURN>.
using the PID for nnn.

12 Invoke Kermit.

Enter kermit  -l /dev/console  -b 9600  -c and press
<RETURN>.

Note:  l is the letter ell

13 If the UXS is not powered on, turn power on now (you can watch the
bootup process)

Note:  Be sure that the toggle switch on the left side of the WSI2
board is in the right (RUN) position.

14 At your system console, press <RETURN>.  You should receive the
login prompt from the UXS

15 Log in as root.

16 Enter setenv TERM xterm and press <RETURN>.

17 Perform the desired procedure (restore software, backup, etc.).  After
the procedure is complete, return to the next step in this procedure.

18 Enter exit and press <RETURN>.

19 Close the system console window.

Note:  It is important to close this window even though you are going
to open another xterm window.

Continued on next page
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7.14 System Console Connection,  Continued

UXS procedure (R200),
continued

Step Action

20 Open an xterm window and become the root user by repeating steps
4-8 of this procedure.

21 Remove the “exclusive use of the system console port (J1) lock”.

Enter rm /usr/spool/uucp/LCK..console and press
<RETURN>.

22 Enter kill -CONT nnn and press <RETURN>.
using the PID recorded earlier for nnn.

23 Close the xterm window.

24 Logout.

HP 712/60 workstation
procedure

Use the following procedure if you are using the serial port on the
Honeywell MP-AMXST1 (HP 712/60 workstation) for the system console.

Starting VT-100 Emulation on a HP 712/60

Note: The coprocessor software defaults to the proper configuration of Serial
Port 1 and no coprocessor configuration actions are required.

Step Action

1 Connect the cable to the RS-232 port on the back of the HP 712/60.
Use the end marked “HOST RS-232 PORT”.

Note:  Henceforth, the term system console means the HP 712/60

2 Connect the cable to the WSI2 I/O board connector for Serial Port 1
(connector J1).  Use the end marked “WSI2 I/O J1”.

3 Login to the HP 712/60.

4 Open an hp terminal window by clicking on the terminal icon.

5 At the “TERM = (hp)” prompt, press <RETURN>.

6 Enter kermit and press <RETURN>.

7 Enter set line /dev/tty00 and press <RETURN>.

8 Enter set baud 9600 and press <RETURN>.

Continued on next page
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7.14 System Console Connection,  Continued

Step Action

9 Enter log session pathname and press <RETURN>.

where pathname is a file path of your choice for a session log file (for
example, /tmp/session.log)

Note:  Do not skip this step, even if you don’t need a log.  On the
712/60, Kermit has a tendency to hang if the session is not logged.

10 Enter connect and press <RETURN>.

11 If the UXS is not powered on, turn power on now (you can watch the
bootup process).

Note:  Be sure that the toggle switch on the left side of the WSI2
board is in the right (RUN) position.

12 At the system console, press <RETURN>.  You should receive the
login prompt from the UXS

13 Log in as root.

14 Perform the desired procedure (restore software, backup, etc.).  After
the procedure is complete, return to the next step in this procedure.

15 Enter exit and press <RETURN>.

16 Close the system console window.

17 Logout.
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